Overview

Have you ever used the Internet, CompuServe, or America Online? If so, you've probably encountered
Zip files. Are you a Windows user? If so, WinZip is THE way to handle these archived files.

WinZip brings the convenience of Windows to the use of Zip files and other compression formats, and is
available in separate versions for both Windows 95/98/NT (32-bit) and Windows 3.1 (16-bit). This help
file describes the 32-bit version.

WinZip features include:

e Windows 95/98/NT integration: WinZip includes long filename support and tight integration with
the Windows 95/98/NT shell. Drag and drop to or from Explorer, or zip and unzip without leaving
Explorer.

¢ Internet support: WinZip features built-in support for popular Internet file formats: TAR, gzip,
UUEncode, XXencode, BinHex, and MIME. ARJ, LZH, and ARC files are supported via external
programs. You can use WinZip to access almost all the files you download from the Internet. In
addition, the freely downloadable WinZip Internet Browser Support Add-On lets you download
and open archives with one click using Microsoft Internet Explorer or Netscape Navigator.

¢ Automatic installation of most software distributed in Zip files: [f a Zip file contains a
“setup” or “install” program, WinZip’s Install feature will unzip the files, run the installation
program, and clean up temporary files.

¢ The WinZip Wizard: This optional feature uses the standard and familiar “wizard” interface to
simplify the process of unzipping and installing software distributed in Zip files. The WinZip
Wizard is not targeted at experienced users, but is ideal for the rapidly growing number of PC
users getting started with Zip files. When these users gain confidence or want to use more
advanced zipping features, the full WinZip Classic interface is just a click away.

¢ Favorite Zip Folders: WinZip lets you organize Zip files into one convenient list that is sorted by
date, making it easier to locate all Zip files, regardless of where they came from or where they are
stored. Unlike the standard File->Open Archive dialog box, the Favorite Zip Folders dialog box
treats the contents of multiple folders as though they were one folder. A Search facility will find
any Zip files lost on your hard disk.

¢ Create files that unzip themselves: WinZip Self-Extractor Personal Edition is now included
with WinZip. Self-extracting files are ideal for sending compressed files to others who may not
own or know how to use file compression software.

e Virus Scanner Support: WinZip can be configured to work with most virus scanners.

WinZip is extremely easy to use! To open an archive simply double click on an archive listed in My
Computer or the Windows Explorer, drag and drop an archive onto WinZip, or use the standard Open
dialog box. The main WinZip window features a list with the names, sizes, and date/time stamps of all
files in the open archive. This list can be scrolled and sorted on any field. A configurable tool bar
provides fast access to commonly used actions. Extensive context sensitive help is always available.

Double clicking on a file in the main WinZip window has the same effect as double clicking in My
Computer or the Windows Explorer. First the file is extracted from the archive. Then, if the file is
executable, it is run. Otherwise, the file is opened by the appropriate application (for example, WordPad
for *.WRI files) based on standard Windows associations.

The Windows Drag and Drop interface is fully supported. You can drag and drop files from WinZip to
other applications. WinZip will extract the files before dropping them on the target application. The
target application will treat the files as if they had been dropped from My Computer or the Windows
Explorer. You can also drop archives on WinZip to open them, or drop files on WinZip to add them to the
open archive.



Magazine Quotes

WinZip won the 1998 Win100 Award from Windows Magazine, the 1998 "World Class" Award from PC
World, and the 1998 "Best Utility" Award from Personal Computer World (UK). In previous years WinZip
was voted "People's Choice Award Winner" at SAIF 97, "Best PC Download" in CMPNet's "Best Of
97" survey, won the PC Week Labs 12/9/96 "Analyst's Choice" Award, the 1996 PC Magazine "Best
Utility" Shareware Award, the 1996 Windows Magazine "Win100" Award, and the 1996 PC Computing
"Best of the Internet" Award for compression.

Here's what magazine reviews say about WinZip:

"Indispensable for anyone who shares files" PC World, 7/98
"Still the tool of choice" Windows Magazine, 6/98

"We like to use WinZip 6.3 for handling Zip files, because it integrates so well into Windows
without taking things over" PC Computing, 3/98

"Easy to use" Computer Shopper, 3/98
"This is a 'must download™ ZDNet 1/27/98

"Version 6.3 sports superior conveniences that leave previous versions and other Windows ZIP
managers in the dust" Computer Currents 1/20/98

"WinZip 6.3 is so good that even Microsoft wouldn't want to compete with it" CINET 1/19/98
"WinZip is perhaps the most essential tool in Power Downloader's arsenal” Download.Com 1/2/98

"WinZip is still the top name in compression utilities - and you shouldn't download anything
without it" PC Computing, 1/98

“Easy to learn yet robust enough to satisfy power users", PC Magazine, 4/8/97
“For working with .ZIP archives, there's no better tool than WinZip", Windows Sources, 3/1/97
“The most essential utility to decompress all those pesky ZIP files", PC World Online, 3/1/97

“It's rare to find one product in a hard-fought market category that bests its competition in nearly
every respect. WinZip 6.2 is one of these products. It towers over the rest of the market.” PC
Week, 12/9/96

“Of the many file-compression and extraction utilities out there, this one is the best - and the
easiest to use” Windows Magazine, 11/96

“Put the squeeze on porky downloads and file transfers with this Windows compression utility”
PC Computing, 10/96

“If you check out a lot of shareware, WinZip is a must.” Home Office Computing, 9/96
“WinZip 6.1 is the easiest compression program to use” Computer Shopper, 8/96

“The best data-compression and archiving utility around” PC Computing, 7/96

“Makes handling compressed files incredibly easy” Windows Magazine, 7/96

“With version 6.1, WinZip continues to be a must have utility for all users” PC Magazine. 7/96

“In the utility category, the WinZip for Windows 95/NT compression software is rated the best.”
Computer Life, 7/96

“Provides all the features of a standard file archiving utility. Then it goes above and beyond the
call of duty in unexpected ways.” Government Computer News, 8/96

“By far the best Windows 95 file-compression utility going” Computer Shopper, 6/96

“Zip front ends ... are all the rage. The undisputed leader of the pack is WinZip - no competition”
PC World, 6/96

“No Windows 95 desktop should be without a file archiving utility, and Nico Mak Computing's



WinZip 6.0 is the one to have.” PC Magazine, 5/96

“Nico Mak continues to add zip to its classic compression utility” Windows Sources, 5/96
“Its a breeze to use” Windows Magazine, 5/96

“Drag and drop everywhere in Windows 95” Byte, 4/96

“The best all-purpose file-compression utility for Windows 95 and Windows NT” Windows
Sources, 3/96

“These days everyone needs a good unzipping utility. This is the best.” PC Computing, 12/95
“Easy Archival” NetGuide, 12/95
One of the “Essential Windows 95 utilities” Windows Magazine, 12/95

“WinZip for Windows 95 is an absolute necessity for file uploads and downloads” PC Computing,
11/95

“Here's good news: The best zipping and unzipping program you can find is available in a
Windows 95 version.” Computer Shopper, 10/95

“Terrifically useful file compression tool” PC World, 10/95

“Windows 95 users get special treatment with the new version of WinZip” Windows Sources,
10/95

“WinZip is extraordinarily handy and one of the best timesavers around” Computer Shopper, 9/95

“WinZip 6.0 deftly integrates the best of the Windows ZIP utilities into the Windows 95
environment” PC Magazine, 9/12/95

“Recommended download” Windows Magazine, 9/95
“Slash your online time” PC Computing, 8/95
“Internet file support adds strength to an already sturdy WinZip” Computer Shopper, 8/95

“Easy drag-and-drop interface when handling popular Internet file compression formats” Online
Access 6/95

“Point-and-click to open ZIP Files” Maximize, 6/95

“For anyone dealing with large amounts of files ... WinZip is an invaluable utility” PC Magazine
UK, 6/95

“If | were stuck on a desert island with a notebook and a CompuServe account, the only utility I'd
want would be WinZip.", PC World 5/95

“WinZip compression program makes a great main squeeze” Knight-Ridder Newspapers 5/21/95



Quick Start Information

There are several ways to get to know WinZip quickly and easily; each tailored to a different style of
learning. Choose one or more of the following approaches

If you haven't installed WinZip yet, see the section titled WinZip Installation for brief installation
instructions.

Some users just like to dive right in! If you have experience with archives and Windows, you
might want to do just that. Context-sensitive help is available at any time by pressing the F1
key.

You can get an overview of the primary operations of WinZip from the section titled Brief
Tutorial.

If you like to “learn by doing,” try the WinZip Tutor Step by Step Instructions, which takes users
step by step through the process of zipping and unzipping.

The WinZip Wizard leads you through the process of zipping or unzipping using a series of
panels or pages in a special window, commonly known as a “wizard.” This convenient
alternative interface for WinZip can help to simplify unzipping and installing software.

Don't miss some of other topics of interest that can help you get started:

The section titled Windows 95/98/NT Shell Integration Examples points out specific examples of
how WinZip integrates with the Windows shell.

The section titled Drag and Drop Interface describes a useful WinZip feature. Be sure to give it a
try!
The section on Hints and Tips lists many helpful ideas for using WinZip.

For assistance in learning how to use the online help system, choose How to Use Help from
WinZip's Help menu.




About Zips and Other Archives

What is an Archive?

Archives are files that contain other files. Typically the files in an archive are compressed. Archives
usually have file names ending with ZIP, LZH, ARJ, or ARC, depending on how they were created.
Archives make it easy to group files and make transporting and copying these files faster.

Typical Uses for Archives:

e Most files available on the Internet and on electronic services like CompuServe and America
Online are distributed as archives. Two benefits of using archives for electronic file distribution
are that only one file transfer operation ("download") is required to obtain all related files, and file
transfer time is minimized because the files in an archive are compressed.

e ltis often useful to send a group of related files to an associate. Rather than distributing
individual files it is often easier to distribute the files as an archive to benefit from the file grouping
and compression.

e Some files are important but not used often. To save disk space simply compress these files into
an archive when they are not used, and decompress them only when needed.

What is a Self-Extracting Zip File?

A self-extracting Zip file is an executable program file (.EXE file) that includes both a Zip file and software
to extract or “unzip” the contents of the Zip file. Users can extract the contents of a self-extracting Zip
file by simply running it. This is convenient, because the end user does not need an unzip program (like
WinZip) to extract files from these self-extracting archives.

WinZip Self-Extractor Personal Edition, included with WinZip, creates Windows self-extracting Zip files.
Archive formats:

e Zip files are the most common archive format. Zip files can span multiple disks, and provide
both compression and file grouping. WinZip does not use external programs to work with Zip
files.

e TAR, Z, GZ, TAZ, and TGZ files are often found on Unix-based Internet sites. TAR stands for
“Tape ARchive”. The TAR format does not provide compression; it is used only to group files.
GZ and Z files are gzip files. GZ and Z files cannot contain multiple files. TAZ and TGZ files are
TAR files compressed in the gzip format.  Since almost all new archives are created in Zip
format, WinZip does not provide facilities to add to or create files in these formats (however, all
other WinZip functions are supported). WinZip does not use external programs when working
with files in these formats.

e File formats such as UUencoded, XXencoded, BinHex, and MIME are used primarily to transfer
binary files by Internet e-mail. If you encounter one of these files, you can open it and extract its
contents with WinZip. You can UUencode an archive using the UUencode entry in the WinZip
Actions pull-down menu. WinZip does not use external programs when working with files in
these formats.

¢ WinZip also handles most files in the old Microsoft Compress format (also known as LZEXPAND
format). However, there are several variations on this format, and Microsoft has not released
documentation on these variations. WinZip issues an appropriate message if you attempt to
decompress a file not supported by your version of Windows. Microsoft Compress files usually
end with a trailing underscore, for example, “commdig.dl_”. Like Z and GZ files, Microsoft
Compress format files contain only one file. This format is used for many files on the Windows
3.1 distribution disks and many older Microsoft products. Note that not all files ending with an
underscore are Microsoft Compress format files. WinZip does not use external programs when
working with files in these formats.

e The Microsoft CAB (short for Cabinet) format is used by most Microsoft setup programs, including
those used to install Windows 95, 98 and NT. CAB files provide both file compression and file



grouping. You can use WinZip to open and extract files the contents of CAB files. WinZip will
handle most self-extracting CAB files. WinZip does not use external programs when working with
CAB files.

ARC, ARJ, and LZH are older formats that provide both grouping and compression, like Zip files.
Unlike other supported file formats, WinZip’s optional support for these formats requires external
programs that are not included as part of the WinZip distribution package (see the section titled
System Requirements for details).



Brief Tutorial
This help file includes a brief tutorial that introduces you to each of the main WinZip concepts and
features to get you working productively as quickly as possible.

You have reached this topic by using the browse buttons (the arrow buttons in the toolbar); the Brief

Tutorial has been placed in its own section, which can be reached by clicking on the text at the bottom of
this page.

You may bypass the tutorial by clicking on the forward browse arrow [ > > ]
Click on Brief Tutorial to exit this section and start the tutorial.



Brief Tutorial - Contents

Click on each tutorial topic, in sequence, to learn all about WinZip:

_I 1. Introducing WinZi 2. The WinZip Window 3. Opening Archives
I 4. viewing Files 5. Extracting Files 6. Creating New Archives
7. Adding Files 8. Deleting _Files 9. Custom Configurations

_| 10. Additional Features

This brief overview tutorial introduces you to each of the main WinZip concepts and features to
get you working productively as quickly as possible.

Note: if you prefer a strict “learning by doing” approach, you may prefer the WinZip Tutor, which uses a
“step by step” approach to introduce new users to zipping and unzipping.

You will get the most benefit from these lessons if you change the size of this Help window to leave
enough room on the screen to have WinZip opened at the same time. As each screen describes an
operation, you may want to try certain things with WinZip to gain an even better understanding. You can
move through the tutorial as quickly or as slowly as you like. If you ever have any questions when you are
using WinZip, remember that context-sensitive help is available by pressing the F1 key.

As you explore this tutorial, you will find highlighted text that will take you to additional information about a
particular topic. If you elect to take the detour, you can click on the Back button at the top of this window
to return to where you left off in the Brief Tutorial.

Important: WinZip offers many convenient ways to work with archives. This tutorial approaches the
topic using the main WinZip window as its base of operations. This is not the only way to access
WinZip's convenient features. For example, you can use WinZip to zip and unzip files without leaving
My Computer or the Windows Explorer. Once you are comfortable with the basic operations described in
this tutorial, be sure to read the sections Windows 95/98/NT Shell Integration Examples and Hints and
Tips.
Next



Brief Tutorial - Introducing WinZip

Click on each tutorial topic, in sequence, to learn all about WinZip:

1. Introducing WinZip

2. The WinZip Window 3. Opening Archives
Il 4. viewing Files 5. Extracting Files 6. Creating New Archives
H7. Adding Files 8. Deleting _Files 9. Custom Configurations

_| 10. Additional Features

WinZip is a tool to make working with Zip and other types of archive files easier. Let's start off by
discussing some of the words used to describe the files and the processes.

Archives are files that contain other files, and Zip files are the most common archive format. Typically,
the files in an archive are compressed. WinZip uses the term “Add” to mean “compress files and add
them to an archive”. “Extract” means “decompress files in an archive, creating separate files on a disk”.
Some people use the verbs “zip” or “pack” instead of Add, and “unzip” or “unpack” instead of “extract”.

See About ZIPS and Other Archives for more detailed information.
Next



Brief Tutorial - The WinZip Window

Click on each tutorial topic, in sequence, to learn all about WinZip:

_I 1. Introducing WinZi 2. The WinZip Window 3. Opening Archives
I 4. viewing Files 5. Extracting Files 6. Creating New Archives
7. Adding Files 8. Deleting _Files 9. Custom Configurations

_| 10. Additional Features

The WinZip window is where you start many of your operations. You can open it through the Start menu.
The WinZip window also opens automatically if you double-click on an archive in My Computer or the
Windows Explorer.

The WinZip window includes standard Windows components. Of particular interest:

The Title Bar displays not just the WinZip product title, but the name of the archive you are currently
working with. The Toolbar provides quick ways of performing the most common tasks. The Main
Window Area displays information about the files in the archive, and you'll find as we get further into this
Tutorial that many operations can be done directly with these files. Finally, the Status Line displays the
number and sizes of currently selected files, along with other archive information.

Next



Brief Tutorial - Opening Archives

Click on each tutorial topic, in sequence, to learn all about WinZip:

_I 1. Introducing WinZi 2. The WinZip Window 3. Opening Archives
I 4. viewing Files 5. Extracting Files 6. Creating New Archives
2 7. Adding Files 8. Deleting Files 9. Custom Configurations

_| 10. Additional Features

The first step is to open an archive. Use the Open toolbar button or select Open Archive from the
WinZip File pull-down menu to activate the standard Open Archive dialog box.

Then, select the archive you want to open in the Open Archive dialog box. This dialog box works just like
the Open dialog boxes in other applications: just select the file you want to open from the list of files. (If
you want to create an archive instead of working with an existing archive, see the section Brief Tutorial -
Creating New Archives).

Once an existing archive is open you can extract or work with the files in the archive. The files in an
archive are listed in a list box in the main WinZip window.

You can look at all the file names, with details, stored in the archive, using the scroll bar, arrow
keys or usual Windows commands.

You can quickly sort the main window by clicking once on the header (e.g. click on “Name” in the
header above the list of files to sort the list by filename).
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Brief Tutorial - Viewing Files

Click on each tutorial topic, in sequence, to learn all about WinZip:

_I 1. Introducing WinZip

2. The WinZip Window 3. Opening Archives
4. Viewing Files 5. Extracting Files 6. Creating New Archives
H7. Adding Files 8. Deleting _Files 9. Custom Configurations

_| 10. Additional Features

You can easily view any of the files stored in an archive by double clicking on the file in the main WinZip
window. WinZip will open the file with the associated application. For example, a Word (.doc) file may be
displayed in Word, and a text (.txt) file in Notepad. When you double click on a program file (.exe), itis
run.

Or, you can view a file with the built-in viewer or a viewer of your choice by selecting View from the
Actions pull-down menu.

Next



Brief Tutorial - Extracting Files

Click on each tutorial topic, in sequence, to learn all about WinZip:

_I 1. Introducing WinZip

2. The WinZip Window 3. Opening Archives
4. viewing Files 5. Extracting Files 6. Creating New Archives

2 7. Adding Files 8. Deleting Files 9. Custom Configurations

_| 10. Additional Features

When you extract a file, WinZip decompresses it and places it in the folder of your choice. You can
restore whole folders and retain the structure of any sub-folders.

If you select Extract from the Actions pull-down menu or click the Extract toolbar button, WinZip lets you
choose the folder where you'd like to place the extracted files. For more details on that dialog box and its
options, press F1 later, when you encounter it, or click on Extracting Files from an Archive now.

Note: if a Zip file contains a “setup” or “install” program, you can use the Install Feature to automatically
extract the files, run the installation program, and clean up temporary files.

Next



Brief Tutorial - Creating New Archives

Click on each tutorial topic, in sequence, to learn all about WinZip:

_I 1. Introducing WinZip

2. The WinZip Window 3. Opening Archives
Il 4. viewing Files 5. Extracting Files 6. Creating New Archives
El7. Ading Files 8. Deleting _Files 9. Custom Configurations

_| 10. Additional Features

You can create a new archive by selecting New Archive from the WinZip File pull-down menu or by
clicking the New toolbar button. This activates the New Archive dialog box.

First, you type the name of the archive you want to create, not the names of the files you want to
compress. This dialog box works similarly to standard Windows file dialog boxes, so you can choose the
drive and folder where the archive will be created. The names of any existing archives on the selected
drive and folder are listed to help you choose a name that is not already in use.

Normally after creating an archive you will want to add files to the archive, so verify that the Add dialog
check box is checked to automatically activate the Add dialog box.

Next



Brief Tutorial - Adding Files to an Archive

Click on each tutorial topic, in sequence, to learn all about WinZip:

1 1. introducing WinZi 2. The WinZip Window 3. Opening Archives
I 4. viewing Files 5. Extracting Files 6. Creating New Archives

7. Adding Files 8. Deleting _Files 9. Custom Configurations

_| 10. Additional Features

You can add files to an existing archive you've opened or to a new archive you've created, as in the
previous section. If the Add dialog box is not displayed, select Add from the Actions pull-down menu or
click the Add toolbar button.

In the Add dialog box, select the files you want to add to the archive. The easiest way to do this is
usually to click on the desired files in the list near the top of the Add dialog box. You can select multiple
files using normal Windows file selection conventions (for example, hold down the shift key while clicking
to select multiple files). For details on alternate ways to specify which files you want to add, see the topic
titted Adding Files to an Archive.

Once you are done making your file selection, click the Add button to add the files. Once WinZip
finishes, it will update the file list in the main window to reflect the new files in the archive.

You can also add files to an archive by dragging the files from My Computer or the Windows Explorer and

dropping the files on the WinZip window. This is described in detail in the section titled Adding a File to
an Archive with the Drag and Drop Interface.

Note: When you add files to an archive, the original files on disk are not deleted. If you want to delete
the original files automatically after the Add operation completes, select Move from the Action combo
box.

Next



Brief Tutorial - Deleting Archives and Files

Click on each tutorial topic, in sequence, to learn all about WinZip:

_I 1. Introducing WinZi 2. The WinZip Window 3. Opening Archives
I 4. viewing Files 5. Extracting Files 6. Creating New Archives
—I 7. Adding Files 8. Deleting Files 9. Custom Configurations

_| 10. Additional Features

WinZip can remove selected files from within an existing archive, or delete the entire archive.  Delete
from the Actions menu activates the Delete dialog box. There are two ways to start the action to delete
files from an archive:

e Select entries from the list box in an open archive, then select the Delete entry from the Actions
pull-down menu or press the Del key.

e Select the Delete entry from the Actions pull-down menu to bring up the Delete dialog box. You
can then specify the file names you want to delete (standard Windows wildcards are accepted, so
you could use “*.doc” to delete all .doc files).

Note: these operations cannot be undone.

To delete an entire archive, select the Delete entry from the Actions pull-down menu to bring up the
Delete dialog box. Then click the Entire Archive option button and the Delete push button.
Alternatively, you can select Delete Archive from the File menu.

Next



Brief Tutorial - Custom Configurations

Click on each tutorial topic, in sequence, to learn all about WinZip:

H1 1. introducing Winzi 2. The WinZip Window 3. Opening Archives
Il 4. viewing Files 5. Extracting Files 6. Creating New Archives
7. Adding Files 8. Deleting _Files 9. Custom Configurations

_| 10. Additional Features

Many WinZip operations can be tailored using configuration options. For example, you can change the
default folders for the Extract and Add dialog boxes. Most options are intended for advanced users. For
an overview of available options see the section titled Options.

Next



Brief Tutorial - Additional Features

Click on each tutorial topic, in sequence, to learn all about WinZip:

_I 1. Introducing WinZi 2. The WinZip Window 3. Opening Archives
I 4. viewing Files 5. Extracting Files 6. Creating New Archives
2 7. Adding Files 8. Deleting Files 9. Custom Configurations

10. Additional Features

This is the end of the Brief Tutorial. As you get to know WinZip better, be sure to explore the following
more advanced features:

e WinZip's Drag and Drop operations simplify archiving.
¢ Internet, America Online, CompuServe, and other online services users: see the section titled
Downloading and Processing Files with WinZip

¢ The Install and Checkout features make it easy to try software distributed in archives.

¢ WinZip can be integrated with the Windows Explorer and the File Manager. See the sections
titled Explorer Interface and File Manager Interface for details.

Reminder: press the F1 key at any time while working with WinZip for context-sensitive help.
You may want to review the tutorial and explore some of the many links it contains by pressing the

buttons above. You can return to the Help Contents page by clicking on the Contents button in the
toolbar.



WinZip stores compressed files in archives. You can think of an archive as being like a folder or
directory, though an archive is really a special kind of file. WinZip recognizes a file as an archive when it
has a .zip or other special extension.



When you compress a file you make it much smaller. Other words for compress are zip and pack.



When you add a file to an archive, WinZip automatically compresses it.



The Switch Interface dialog box is displayed if you start WinZip with the Wizard interface mode and close
WinZip while using the Classic interface, or vice versa. This dialog box gives you a chance to control
whether WinZip will start in Wizard or Classic mode next time you run WinZip.



WinZip can help you find Zip files if you don't know exactly where they are. Select Search hard disks
on this PC to search all your hard drives on your PC (network disks and CD-ROM disks are not
searched). Select Search favorite folders to search for Zip files in your Favorite Zip Folders. Select

Search disk to search a specified disk (for example, a floppy disk or CD-ROM). Select Let me find it if
you want to look for the file yourself.



File Type Filters

The File/New Archive, File/Open Archive dialog boxes use the file type filters in the following table. The
File/Favorite Zip Folders dialog box uses the first three entries in this table.

Zip files *.Zip
all archives *.Zip;*.z;*.gz;* tz;* taz;* .tgz;*.I1zh;*.arj;*.arc;*.tar; *.cab

*

encoded files .Uu; *.uue; *.xxe;*.bhx;*.b64;*.hgx; *.mim

archives and .exe files *.Zip;*.z;*.gz;* tz;* taz;*.1gz;*.1zh;*.arj;*.arc;* tar;
*.cab;*.exe

archives, encoded, and .exe files *.Zip;*.z;*.gz;* tz;* taz;*.t1gz;*.I1zh;*.arj;*.arc;* tar;
*.cab;*.exe; *.uu; *.uue; *.xxe; *.bhx;*.b64;*.hgx; *.mim

all files (*.*) L

Downloading and Processing Files with WinZip
WinZip has special features that make it simple and convenient to download and process compressed
files from the Internet and online services like America Online and CompuServe.
Click to choose the method about which you would like to learn more:
Downloading From The Internet
Downloading From America Online, CompusServe, and Other Online Services



Downloading From The Internet

You can use WinZip to work with archives you download from the Internet just as you do with other
archives, or you can use the free Internet Browser Support Add-On to simplify your work with Internet
downloads, as described below.

The free WinZip Internet Browser Support Add-On will automate much of the
work normally associated with downloading compressed files from the Internet. When you click
on an archive using Netscape Navigator/Communicator or Microsoft Internet Explorer, WinZip will
take over when the download is completed. WinZip automatically moves the downloaded file to
your download folder (initially set to c:\download) and then opens the file. This add-on is
available for download from the web page http://www.winzip.com/ibrowser.cgi (this free add-on is
not part of the WinZip distribution package).

If you download an archive without the add-on the current versions of Microsoft
Internet Explorer and Netscape Navigator/Communicator will give you a choice of opening the
archive or saving it to disk. If you choose to open the archive, you should be aware that the
Internet Browser will probably delete the file when the browser is closed. To avoid this problem,
use the Internet Browser's “save to disk” option, and specify an easy-to-remember folder, for
example, c:\\download.

Problems Downloading? \When you download a file, many things can go wrong, resulting in a damaged
copy of the file that WinZip cannot open. The solution to most download related problems is simply
to download the file again. For more information on resolving Internet download related problems,
please check the web page http://www.winzip.com/downprob.htm.

Note:

Many files available for download on the Internet are executable (.exe) files. The WinZip Internet
Browser Support Add-On will not try to handle these files. However, if the .exe file is a self-extracting Zip
file, you can open and process it using the WinZip Classic File->Open dialog box, or by right-clicking on
the file and selecting “Open with WinZip”.

Related Topics:
Downloading from America Online, CompuServe, and other online services



Downloading from America Online, CompuServe, and Other
Online Services

An online service with its own access software will generally have a specific folder on your computer
where newly downloaded files are placed. For example, America Online uses a folder named c:\aol\
download, and CompuServe uses a folder named c:\cserve\download. After you download a Zip file from
one of these services in the normal manner, it's easy to use WinZip to open and process the file.

If you use the WinZip Wizard Interface, start WinZip by clicking on its icon, then click
the Next button to move to the Select Zip File screen. The WinZip Wizard's Select Zip File
screen shows all the Zip files in your Favorite Zip Folders with the most recently downloaded files
at the top of the list, along with the folder in which they are located.

If your file or the special download folder is not shown, you can have WinZip search for the item
by clicking on the Search button, then clicking Search hard disk(s) on this PC, and then clicking
OK. WinZip will check all your hard drives and make a new list of Zip files, and update your
favorite folders (the places where WinZip has found Zip files stored on your PC). When the
process is complete, newly downloaded files should be near or at the top of the list. Highlight the
file you wish to work with to continue with the Wizard's unzipping process.

See the section titled WinZip Wizard for details on using the Wizard.

If you use the WinZip Classic Interface, start winzip by clicking on its icon, then click
the Favorites toolbar button or select Favorite Zip Folders from the File pull-down menu. The
resulting dialog box shows all the Zip files in your Favaorite Zip Folders with the most recently
downloaded files at the top of the list, along with the folder in which they are located.

If your file or the special download folder is not shown, you can have WinZip search for the item
by clicking on the Search button, then clicking Search hard disk(s) on this PC, and then clicking
OK. WinZip will check all your hard drives and make a new list of Zip files, and update your
favorite folders (the places where WinZip has found Zip files stored on your PC). When the
process is complete, newly downloaded files should be near or at the top of the list. Highlight the
file you wish to work with, then click the Open button.

See the section titled Hints For Working With Downloaded Files for more suggestions.

Note:

Many files available for download on the Internet are executable (.exe) files. WinZip's Internet Browser
Support will not try to handle these files. However, if the .exe file is a self-extracting Zip file, you can
open and process it using the WinZip Classic File->Open dialog box, or by right-clicking on the file and
selecting “Open with WinZip”.

Related Topics:
Downloading from the Internet



UUencoded, XXencoded, BinHex, and MIME files

This help file includes a section outlining how WinZip can open and extract UUencoded, XXencoded,
BinHex, and MIME files (base64, plain/text, and quoted-printable), and can UUencode files. It also
explains the need for these features and abilities, and includes instructions for using them.

You have reached this topic by using the browse buttons (the arrow buttons in the toolbar); the Brief
Tutorial has been placed in its own section, which can be reached by clicking on the text at the bottom of
this page.

You may bypass this section by clicking on the forward browse arrow [ > > ]

Click on UUencoded, XXencoded, BinHex, and MIME files to exit this section and learn more about these
files and how WinZip can serve your needs.




UUencoded, XXencoded, BinHex, and MIME files

WinZip can open and extract UUencoded, XXencoded, BinHex, and MIME files (base64, plain/text, and
quoted-printable), and can UUencode files. This section explains the need for these features and abilities,
includes instructions for using them, and shows how they can bring a whole new dimension to your e-mail
operations.

Use the browse buttons above or the index below to page through this tutorial, and learn
about using these important and useful WinZip features.

These instructions assume that you understand basic Windows and WinZip operations, and the basic use
of your e-mail program.
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Sending Files using Internet Mail

If you have a direct connection to the Internet, you may already be using an e-mail program that allows
you to attach files to messages. However, many e-mail programs, including MSMail and some versions of
CompuServe Information Manager (WinCIM), cannot easily transfer files to Internet addresses. In the
case of CompuServe, users with older accounts who have not converted to “new mail” cannot easily
send files beyond the bounds of their own service, to Internet subscribers and others. WinZip allows you
to send and receive files using nearly any e-mail program, including these two.

Note: If your e-mail program does have the ability to transfer files, consider using WinZip to compress
them before transfer -- it will usually take far less time since the file will be smaller. If the recipients are
unfamiliar with Zip archives, you can use WinZip to create a self-extracting archive for their convenience.
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The Why behind UUencoding and Other Schemes

The Internet was not designed to carry binary (program and other non-text files) files. It is able only to
transfer messages made up of conventional text (printable ASCII) characters. In order to get around that
limitation, UUencode and other methods were created.

These solutions all perform the same basic operation: they encode the non-transferable binary file into
ASCII characters that the e-mail system can handle. The person receiving the message can then decode
the strings of characters to recreate the original file. Perhaps you have seen such one of these completely
unintelligible messages; here's an example:

:=: Part 001 of 001 of file encoded.txt

begin 666 encoded.txt

M5&55="$-"Q@T*1V5N=&QE (%) E861E<CH-"Q@T*5&AI<R!I<R!N;W1H:6YG (&UO
M<F4Q@=§AA;B!A ('1E<WOQOFEL92!C<F5A=&5D('10 (' !'R; W9I9&4@9F]DI9&5R
M(&90<B!T:&4@=F%R:6]U<R!E; F-O9&EN9R!S8VAE; 653+B!)9B!Y;W4@87)E
M('5S:6YG(&ET ('10('1E<WOL (&-0; F=R871U; &%T:6]N<R!0O;B!Y;WS5R (&%G
M:6QI="D@Q:6XEA8WST=&ENIRPE<&SS=&ENIRPQA<VSV:6YG+"!A; F0@9&5C;V1I
1 F<@=7-1;F<@5VENGFEP+QT*#0I%;FIO>2S"

end

WinZip can easily open and extract UUencoded, XXencoded, BinHex, and MIME files (base64, plain/text,
and quoted-printable) that have been sent to you, and create Uuencoded files for you to send.
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Receiving and Preparing Files for Decoding

The message you receive with an encoded file will need to be prepared for the simple WinZip decoding
operation. The steps you take will depend on the e-mail program you are using.

If you are using CompuServe Information Manager (WinCIM),
1. Double-click on the message to open it,
2. Select Save As from the File menu item,
3. Enter a file name using .UUE as the extension; for example: FILENAME.UUE.
If you are using MSMail,
1. Highlight the message (DO NOT open it; large messages are not handled well by MSMail)
2. Select Save As from the File menu item,
3. Enter a file name using .UUE as the extension; for example: FILENAME.UUE.

If you are using another e-mail program, one of the two methods described above may also work with
your program. Be aware that some e-mail programs may crash or cut off parts of unusually large
messages, so saving them as a file without opening them is the preferred method.

Your e-mail program may save a message attachment as an external file in a folder designated to receive
them. In that case, it may automatically be named; you may wish to rename it, using a .UUE extension,
for maximum convenience.

Sometimes you may receive multiple messages, where a file is split up into more than one message
because of size limitations. You will need to use a text editor or the DOS COPY file command to paste the
files together into one large file, and save it as a text file with a .UUE extension.
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Decoding Files using WinZip

You do not need to worry if the file being received is UUencoded, XXencoded, BinHex, or a MIME file
(baseb4, plain/text, and quoted-printable). WinZip will detect the method being used and automatically
decode it.

As is the case with zip archives, WinZip offers more than one way to open encoded files. For example:
e Double-click on the file with the .UUE extension

e WinZip will execute and decode the file. If it is a Zip archive, it will offer to open it. If it has not
been compressed, it will be shown in the usual manner.

e Use WinZip in the regular manner to Extract the file to your folder of choice.

Note: You can also open a file using WinZip's Open toolbar button, or drag and drop a file into WinZip,
regardless of the file's extension.
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UUencoding a File using WinZip

WinZip UUencodes Zip archives for mailing, so you must choose and open an existing Zip file to encode
or create a new one.

e If the file is already archived as a Zip file, open it in WinZip using your favorite method.

¢ |f the file(s) you wish to send are not already archived, use WinZip to create a Zip file, and leave
the program open for the next step.

¢ Click on the Actions menu item, and choose UUencode.

A UUencoded file has been created from your Zip archive. For example, you will find a TESTFILE.UUE
file in the same folder along with your original TESTFILE.ZIP.
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Mailing a UUencoded File

How you include a UUencoded file in a message will depend on your e-mail program.

If you are using CompuServe Information Manager (WinCIM) with “old mail” (i.e., you have an older
account and have not converted to “new mail"),

1. Create a message in the usual manner.

Note: If you are sending a file to another CompuServe address, it is unnecessary to UUencode i,
but zipping it using WinZip will shorten transmission times.

Click on the Attach button to open WinCIM's File Attachment window.
If you are using WIinCIM 2.0, click on File (when using version 3.0, this step is not necessary).
Use the standard file dialogs to choose the .UUE file you created in the previous step.

If you are using CompuServe Information Manager 3.0, highlight the attached file in the Attach
Files dialog box, select “Text” in the File Type combo box, then click OK (when using version 2.0,
this step is not necessary).

o R~ eDn

6. E-mail your message as you would normally.
If you are using MSMail,

1. Create a message in the usual manner.

2. Click on the menu item Attach, and select File.

3. Use the familiar file dialogs to choose the .UUE file you created in the previous step, then click
OK.

4. E-mail your message as you would normally.

If you are using another e-mail program, one of the two methods described above may also work with
your program. A “Send File” or similar option may be available and of use in this situation. It may be
necessary to open the .UUE file you have created using a text editor, copy the entire contents, or portions
of it, to the Windows clipboard, and paste it into your open e-mail message. Further information on
handling large files is included in the next topic, Hints, Tips, & Troubleshooting.
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Hints, Tips, & Troubleshooting

WinZip makes decoding these file attachments very convenient. Here are some hints to make the road
even smoother:

The most common problems we encounter with files than cannot be decoded are incomplete data and
missing header information. The integrity of the message is critical, and the header must be intact for
decoding. We have included short examples of each of the following encoding formats. You may find
them helpful for comparison purposes with messages you receive, to confirm that they appear properly
encoded and are not missing header and closing data. Click to review any of these brief file examples.

UUencoded Example XXencoded Example BinHex Example MIME (base64)
Example

Multi-Part Encoded Files must be combined before WinZip can process them. If you encounter
encoded data spread across multiple files, you can either combine the parts using a text editor, and then
open them with WinZip, or you can use another program, like the UUDeview package from Frank Pilhofer.
(WinZip's decoding subroutines are based on the UUDeview package.) The original UUDeview is a text
mode command line driven program, or you can download a Windows interface by Michael Newcomb.
These free programs are available from the Internet addresses http://www.uni-frankfurt.de/~fp/uudeview
(Germany) and http://www.miken.com/uud (USA), respectively.

Further information about encoding files can be found in many places on the Internet. A good place to
start is the “Introduction to Decoding” article on the UUDeview Home Page at
http://www.uni-frankfurt.de/~fp/uudeview. The MIME specification is defined in RFC 1521, and is widely
available on the Internet.

Bug Reporting: If, after examining and confirming that a file seems properly encoded, you believe that
WinZip should handle it, please contact WinZip support. Send e-mail to support@winzip.com with
details, and include a zip archive of the file so that it is not changed by any mail gateways or e-mail
program. Do not remove any header or other information. Please include the name of the program that
created it, if possible. Smaller files are preferred over huge sample files. We will examine the file and
respond as soon as possible.
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UUencoded Example
Here is an example of a UUencoded file:

begin 666 encoded.txt
M56&5S="$-"QRQT*1V5N=6QF (%) E861E<CH-"QT*5&ATI<R! I<R!N;W1H:6YG (&UO

M<F4@=&AA;B!A ('1E<WOROFELO2!C<F5A=&5D('10 (' !R; WOI9&4@9F]D9&5R
M(&90<B!T:&4@=F%R:6]U<R!E; F-O9&ENOR! S8VAE; 65S+B!) 9B!Y; W4Q@87)E
M('55:6YG(&ET ('10 ('1E<WOL (&-0; F=R871U; &%T:6]N<R!0;B!Y;W5R (&%G
M:6QI="'DQ:6X@8W5T=4ENIRPR<&%S=&ENORPR<VSV:6YG+" ! A; FORO&5C; V1T
:;F<@=7-I1;F<@SVENGFEP+QT*#0I%;FIO>2S"

end

Return to Hints, Tips, & Troubleshooting



XXencoded Example
Here is an example of a XXencoded file:

begin 666 encoded.txt
hJ4JnR0O02BOU0BFqJiR41Z637ZMKFZQXcB0U08J4VdQOm-dQOm-1iPrFcOKtb64p]
hQaTIUR4AVVPW-V65FZQrEUNaZgNG-XQaJVR4JY65F ] 65-mPrNdN4 IUNaxYN4 Jm
h64NjQW-004IURa3mOKxpQm-Z2PaBjN4ZiNm-nMgVZPKInOW-7NW-tPrIUML7Z
h65Jn0OKtb64Z065Fj65FZQrEg64BjPaRmMLFpP4300KxiQm-jPW-tPrdm643b
hOK1dR5YUOKsUMrJoR4Z1iNmkUQ43nR4ZiNmkUQg3gOKtb90-VPaEUN4JXPgFd
OPaQURLBAPaQUJgZiKaZk9Uo81Ed3PadjSG2+

+

end

Return to Hints, Tips, & Troubleshooting



BinHex Example

Here is an example of a BinHex file:

VGVzdCENCgOKR2VUdGx1IFJ1YWR1cjoNCgOKVGhpcyBpcyBub3RoaW5nIGlvemUgdGhhbiBhIHRL
c30g9ZmlsZSBjcmVhdGVkIHRVIHBYb3ZpZGUgZm9kZGVyIGZvciB0aGUgdmFyaW91lcyBlbmNvZGlu
ZyBzY2hlbWVzLiBJZiB5b3UgYXJ1IHVZzaWSnIG10IHRVIHR1c3QsIGNvbmdyYXR1bGFOaWOucyBv

biB5b3VyIGFnaWxpdHkgaW4dgY3V0dGluZywgcGFzdGluZywgc2F2aW5nLCBhbmQgZGVib2Rpbmecg
dXNpbmcgV21uWmlwLg0KDQpFbmpveSE=

Return to Hints, Tips, & Troubleshooting



MIME (base64) Example

Here is an example of a MIME file:

Content-Type: application/octet-stream; name="encoded.txt"
Content-Transfer-Encoding: base64

Content-Disposition: inline; filename="encoded.txt"
Content-MD5: V8ttTjZgvmMkzwVFKr50lw==

VGVzdCENCgOKR2VudGx1IFJ1YWR1cjoNCgOKVGhpcyBpcyBub3RoaWsnIGlvemUgdGhhbiBh
THR1c3QgZmlsZSBjcmVhdGVkIHRVIHBYb3ZpZGUgZm9kZGVyIGZvciB0aGUgdmFyaW91lcyBl
bmNvZGluZyBzY2hlbWVzLiBJZiB5b3UgYXJ1IHVZzaW5nIG10IHRVIHR1c30sIGNvbmdyYXR1
bGF0aWoucyBvbiB5b3VyIGFnaWxpdHkgaWdgY3V0dGluZywgcGFzdGluZywgc2F2aW5nLCBh
bmQgZGVib2RpbmcgdXNpbmcgV21luWmlwLgOKDQOpFbmpveSE=

Return to Hints, Tips, & Troubleshooting



System Requirements

The 32-bit version of WinZip requires Windows 95, Windows 98, or Windows NT 4.0 or later. It will not
run under Windows NT 3.1 or 3.5.

No other programs are required to add or extract files from Zip files. However, some optional
WinZip operations do require external programs or files:

e Optional virus scanning support requires that a supported virus scanning program be installed on
your system. See below for specific information and how to find a list of virus scanners
automatically detected by WinZip.

e Optional support for some older formats (ARC, ARJ, and LHA) requires one of the supported
programs listed below. For step by step instructions on installing these programs see the section

titled Installing Optional External Programs.
Here are more details on some of the optional programs:

¢ You can create self-extracting Zip files with WinZip Self-Extractor Personal Edition, included with
WinZip, or you can use the full WinZip Self-Extractor, a $49 add-on, which includes features
tailored for software distribution, and the ability to create a single self-extracting Zip file that can
be run under either MS-DOS or Windows.

e To access LZH files, the LHA.EXE program from Haruyasu Yoshizaki is required. You can
download LHA.EXE from most bulletin boards. The latest version is distributed in the self-
extracting LZH file LHA213.EXE. WinZip has been tested with LHA 2.13 and will not work with
earlier versions (in particular, it will not function with LHARC, the predecessor to LHA).

e To access ARJ files, the ARJ program from Robert Jung is required. You can download the
Shareware version of ARJ from most bulletin boards. The latest version is distributed in the self-
extracting ARJ file ARJ250.EXE or ARJ260.EXE. WinZip has been tested with ARJ 2.5 and 2.6
and will not work with earlier versions.

e To access ARC files, one of the following programs is required:

ARCE.COM and ARC-E.COM version 4.0e - Vern Buerg's ARC extraction utility, available on
CompuServe and other bulletin boards. WinZip was not tested with earlier versions.

PKXARC.COM version 3.5 from PKWARE, Inc. WinZip was not tested with earlier versions.
This program is still available on some bulletin boards.

PKXARC.EXE version 3.6 from PKWARE, Inc. This program is still available on some bulletin
boards.

PKUNPAK.EXE version 3.61 from PKWARE, Inc. This program is still available on some bulletin
boards.

ARC.EXE version 5.20 or 6.0 from System Enhancement Associates, Inc. This is the last
version of ARC available as Shareware, and is still available on some bulletin boards. WinZip
was not tested with earlier versions. SEA's address is 925 Clifton Ave., Clifton, NJ 07013.

WinZip will automatically detect several popular virus scanners; for a current listing, visit the WinZip web
site at http://www.winzip.com/xvirus.htm.

WinZip can also be configured to work with most virus scanning utilities. For important details, see the
section titled Virus Scanner Configuration.
Some toolbar configuration options require version 4.71 or later of the Windows Common Control library.

This library is part of Windows 98, Microsoft Internet Explorer 4.0, and is available as a separate
download from the Microsoft web site as described in the section Windows Common Control Library.



WinZip-Related Files

Filename Description

README.TXT introductory information

WINZIP.TXT extracts from online documentation
WINZIPFM.DLL File Manager Extension dynamic link library
WINZIP.HLP documentation in online hypertext help format

WZSEPE32.EXE
WZWIZARD.HLP

WinZip Self-Extractor Personal Edition
documentation for the Wizard interface

EXAMPLE.ZIP example file used by tutorial

WZTUTOR.HLP documentation for tutorial

WINZIP.CNT help contents file

W2z32.DLL required dynamic link library

WINZIP32.EXE required executable

WZSHLEXT.DLL Windows Explorer Shell Extension dynamic link library
WZFM32.DLL File Manager Extension dynamic link library
WZCAB.DLL required dynamic link library

WZCAB2.DLL required dynamic link library

WZ.COM required executable

WZ.PIF required Program Information File

LICENSE.TXT license agreement/warranty

ORDER.TXT order form

VENDOR.TXT information for Shareware Distributors and Disk Vendors
WHATSNEW.TXT list of recent changes

FILE_ID.DIZ brief description for bulletin boards

WinZip Installation

To install WinZip from the distribution disk, choose Run from the Start menu, type a:setup, and press the
Enter key.

The Setup program will issue a number of prompts. Unless you have a reason to override the defaults it
is strongly recommended that you accept the installation default settings (just press OK, Yes, or Next, as
appropriate).

If you are interested in information on installing WinZip site licenses in a networked environment, please
see the web page http://www.winzip.com/site install.htm.




WinZip Uninstallation

There are three ways to uninstall WinZip should you wish to do so.
Control Panel

Activate the Control Panel, double click Add/Remove Programs, and double click on the WinZip list box
entry.

Start Menu
From the Start menu, click Programs, then WinZip, and then Uninstall WinZip.
Run Dialog:

You can also uninstall WinZip by running WINZIP32.EXE and specifying the /uninstall parameter. For
example, if WinZip is installed in your c:\winzip folder, in the Run dialog box, type

c:\winzip\winzip32.exe /uninstall
Technical details:
The “Uninstall WinZip” procedure performs the following steps:
Verify that it is safe to uninstall
2. Remove WinZip File Manager Extension from WINFILE.INI if it is installed

3. Delete files in WinZip folder if they were installed by this version of WinZip and if the file's
date/time stamp matches WINZIP32.EXE. The WINZIP.GID, WINZIP.FTS, and WINZIP.PIF files
are deleted regardless of their date/time stamp.

4. Remove any WinZip file associations from WIN.INI

5. Remove [WinZip] entry from WIN.INI

6. Remove the WinZip icons and Start menu entries

7. Remove the WinZip entries from the registry



Installing Optional External Programs

WinZip includes built-in support for the ZIP, CAB, Microsoft Compress, gzip, TAR, UUencode, XXencode,
BinHex, and MIME formats, so no other programs are required for most WinZip operations. However,
virus scanning and operations involving ARC, ARJ, and LZH files require external programs. These
optional external programs are not distributed with WinZip. You must tell WinZip where to find these
programs as described in the section titled Program Locations. The following sections provide step by
step examples of how to install LHA and ARJ.

Remember: the use of these external programs is optional. If you are just getting started with WinZip
you will probably want to skip this section and work without the external programs until you encounter a
need for them (and are more familiar with WinZip).

These instructions assume you are comfortable working with My Computer or the Windows Explorer,
know how to use standard Windows features such as dialog boxes and menus, and have a little
experience using WinZip. See the section titled Quick Start for introductory information and how to
quickly become familiar with WinZip.

Note: The first step in installing an external program is to acquire the external program. See the section
titled System Requirements for information on obtaining these programs.

Related Topics:
Installing LHA
Installing ARJ



Installing LHA

Here are step by step instructions for installing LHA, an optional external program required to work with
LZH files.

1.

LHA is distributed as a self-extracting archive called LHA213.EXE. First download LHA213.EXE
from your favorite online service.

Use My Computer or the Windows Explorer to create the folder C:\LHA. You can use a different
folder but then you will need to substitute that folder name in the following instructions.

Use My Computer or the Windows Explorer to copy LHA213.EXE from your download folder to
the C:\LHA folder.

Double click on LHA213.EXE to run it. This will cause the files in LHA213.EXE to “self-extract”
into the C:\LHA folder. Then go back and delete C:\LHA\LHA213.EXE, as it is not needed for
day-to-day work with LHA and WinZip.

Start WinZip. Pull down the Options menu and select Configuration, then click the Program
Locations tab.

In the LHA field in the Configuration | Program Locations dialog box type
c:\lha\lha.exe

and press the OK button.

That's all there is to installing LHA. You can now access .LZH files (created by LHA) the same way you
access Zip files.



Installing ARJ

Here are step by step instructions for installing ARJ, an optional external program required to work with
ARJ files.

1.

ARJ is distributed as a self-extracting archive called ARJ250.EXE or ARJ260.EXE. First
download the file from your favorite online service.

Use My Computer or the Windows Explorer to create the folder C:\ARJ. You can use a different
folder but then you will need to substitute that folder name in the following instructions.

Use My Computer or the Windows Explorer to copy the ARJ installation executable from your
download folder to the C:\ARJ folder.

Double click on the file to run it. This will cause the files to “self-extract” into the C:\ARJ folder.
Then go back and delete C:\ARJ\ARJ250.EXE or ARJ260.EXE, as it is not needed for day-to-day
work with ARJ and WinZip.

Start WinZip. Pull down the Options menu and select Configuration, then click the Program
Locations tab.

In the ARJ field in the Configuration | Program Locations dialog box type
c:\arj\arj.exe

and press the OK button.

You can now access ARJ files the same way you access Zip files.

Note: like WinZip, ARJ is not free software. As with all shareware, if you use these programs you should
register them with the appropriate vendor. See the license.doc file in your ARJ folder for details.

Note: ARJ 2.60 provides long filename support. However, due to limitations in ARJ 2.60, this feature is not
available under Windows NT.



Copyright/License/Warranty

WinZip® Copyright © 1991-1998 by Nico Mak Computing, Inc.
All rights reserved.

This license applies to the registered version of WinZip. If you are using an evaluation version of WinZip,
see the section titled titled Evaluation License.

License Agreement

You should carefully read the following terms and conditions before using this software. Unless you have
a different license agreement signed by Nico Mak Computing, Inc. your use of this software indicates your
acceptance of this license agreement and warranty.

Registered Version

One registered copy of WinZip may either be used by a single person who uses the software personally
on one or more computers, or installed on a single workstation used nonsimultaneously by multiple
people, but not both.

You may access the registered version of WinZip through a network, provided that you have obtained
individual licenses for the software covering all workstations that will access the software through the
network. For instance, if 8 different workstations will access WinZip on the network, each workstation
must have its own WinZip license, regardless of whether they use WinZip at different times or
concurrently.

WinZip Self-Extractor Personal Edition, included with WinZip, may be used at workstations licensed to
use the registered version of WinZip to create an unlimited number of freely distributable royalty-free self-
extracting ZIP files. Self-extracting ZIP files created by WinZip Self-Extractor Personal Edition contain,
among other things, a portion of WinZip Self-Extractor, including copyrighted software, proprietary
notices, and identifying information (the “Extraction Software"). No registered user may alter or modify
the Extraction Software. You cannot give anyone else permission to modify the Extraction Software.

Governing Law

This agreement shall be governed by the laws of the State of Connecticut.

Disclaimer of Warranty

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD “AS I1S” AND WITHOUT
WARRANTIES AS TO PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES
WHETHER EXPRESSED OR IMPLIED. In particular, there is no warranty for the optional virus scanning
feature (WinZip does not scan for viruses, it simply runs external programs that claim to perform this
function). Because of the various hardware and software environments into which WinZip may be put,
NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data
before relying on it. The user must assume the entire risk of using the program. ANY LIABILITY OF
THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF
PURCHASE PRICE.



Evaluation License

WinZip® Copyright © 1991-1998 by Nico Mak Computing, Inc.
All rights reserved.

This license applies to the evaluation version of WinZip. If you have purchased a license for the
registered version of WinZip, see the section Copyright/License/Warranty.

License Agreement

You should carefully read the following terms and conditions before using this software. Unless you have
a different license agreement signed by Nico Mak Computing, Inc. your use of this software indicates your
acceptance of this license agreement and warranty.

Evaluation and Registration

This is not free software. Subject to the terms below, you are hereby licensed to use this software for
evaluation purposes without charge for a period of 21 days. If you use this software after the 21 day
evaluation period a registration fee of $29 is required. Payments must be in US dollars drawn on a US
bank, and should be sent to Nico Mak Computing, Inc., P.O. Box 540, Mansfield, CT 06268. Credit card
ordering and quantity discounts are available, as described in the section Ordering Information. When
payment is received you will be sent a registered copy of the latest version of WinZip.

Self-extracting ZIP files created by WinZip Self-Extractor Personal Edition (distributed as part of the
WinZip evaluation package) contain, among other things, a portion of WinZip Self- Extractor, including
copyrighted software, proprietary notices, and identifying information (the “Extraction Software"). You
may not alter or modify the Extraction Software and cannot give anyone else permission to modify the
Extraction Software. UNDER NO CIRCUMSTANCES ARE YOU LICENSED TO DISTRIBUTE SELF-
EXTRACTING ZIP FILES CREATED BY THE EVALUATION VERSION OF WINZIP SELF-EXTRACTOR
PERSONAL EDITION.

Unregistered use of WinZip or WinZip Self-Extractor Personal Edition after the 21-day evaluation period is
in violation of U.S. and international copyright laws.

Governing Law

This agreement shall be governed by the laws of the State of Connecticut.

Disclaimer of Warranty

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD “AS IS” AND WITHOUT
WARRANTIES AS TO PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES
WHETHER EXPRESSED OR IMPLIED. In particular, there is no warranty for the optional virus scanning
feature (WinZip does not scan for viruses, it simply runs external programs that claim to perform this
function). Because of the various hardware and software environments into which WinZip may be put,
NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data
before relying on it. The user must assume the entire risk of using the program. ANY LIABILITY OF
THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF
PURCHASE PRICE.

Distribution of Evaluation Version

Provided that you verify that you are distributing the evaluation version (select About from the WinZip
Help menu to check) you are hereby licensed to make as many copies of the evaluation version of this
software and documentation as you wish; give exact copies of the original evaluation version to anyone;
and distribute the evaluation version of the software and documentation in its unmodified form via
electronic means. There is no charge for any of the above.

You are specifically prohibited from charging, or requesting donations, for any such copies, however



made; and from distributing the software and/or documentation with other products (commercial or
otherwise) without prior written permission.



WinZip 7.0 Ordering Information

Disk orders for WinZip 7.0 for Windows 95/98/NT will be shipped by postal mail (airmail if you are outside
North America) within two business days after they are received; there is no additional charge for the
postage.

Customer information is considered confidential and will not be shared or distributed to any third party.
All orders are subject to the WinZip License Agreement.
Immediate Online Delivery

Immediate online delivery of registered copies of WinZip is available for credit card orders placed via the
Internet using the Order link on the WinZip home page: http://www.winzip.com. You can place orders for
delivery by postal mail (or airmail outside North America) using the Internet order forms or as described
below.

Ordering by Check

To order by check, send the order form and a check payable to Nico Mak Computing, Inc., P.O. Box 540,
Mansfield, CT 06268-0540 USA. Payments must be in US dollars drawn on a US bank, or you can send
international postal money orders in US dollars. Click here to view a ready-to-print Order Form.

Credit Card Orders

You can place secure credit card orders on the Internet using the Order link on the WinZip home page at
http://www.winzip.com. For information on credit card ordering by phone, fax, e-mail, or postal mail, click

here: Credit Card Ordering.

CompuServe Registration

For information on having the registration fee added to your CompuServe bill, click here: CompuServe
SWREG Ordering.

Purchase Orders

For information on using purchase orders click here: Purchase Orders.

Ordering Options Outside the USA and Canada

For information on local registration click here: Ordering Options Outside the USA and Canada.
Site licenses

A site license for WinZip entitles an organization to receive one copy of the distribution package and
duplicate the software as necessary for use within the organization on the specified number of computers.
See the table below for site license pricing. For higher quantity pricing, please send e-mail to
sitesales@winzip.com.

Pricing
WinZip Single Copy $29 each
WinZip Site Licenses:
2 to 9 computers: $22 each
10 to 24 computers: $17 each
25 to 49 computers: $14 each
50 to 99 computers: $10 each

100 to 199 computers: $7 each
200 to 499 computers: $6 each
500 to 999 computers: $4 each

Connecticut residents please add 6% sales tax.
Prices guaranteed through December 1999.






WinZip® 7.0 Order Form/lnvoice

To print this order form, select Print Topic from the File pull-down menu.

To order by check, send this order form and a check payable to Nico Mak Computing, Inc., P.O. Box 540,
Mansfield, CT 06268-0540 USA. Payments must be in US dollars drawn on a US bank, or you can send
international postal money orders in US dollars.

All orders are subject to the WinZip License Agreement. Prices guaranteed through December 1999.
Note: this ordering information is for the English version of WinZip.
Customer information is considered confidential and will not be shared or distributed to any third party.

WinZip Single Copy _at $29 each =
WinZip Site Licenses:

2to9 computers: __ at $22 each =

10 to 24 computers: __ at $17 each =

25to 49 computers: __ at $14 each =

50 to 99 computers: __ at $10 each =

100 to 199 computers: __ at $7 each =

200 to 499 computers: _ at $6 each =

500 to 999 computers: at $4 each =

Connecticut Residents add 6% sales tax:
Total payment:

Date:

Name:

Company:

Shipping Address:

City, State, Zip:

Country:

Day Phone:

E-Mail address:

How did you hear
about WinZip?

Comments:

WinZip® 7.0 Credit Card Order Form

To print this order form, select Print Topic from the File pull-down menu.



You can place credit card orders by phone, fax, e-mail, or postal mail through PsL, a credit card ordering
service. The best way to reach PsL is by fax to 1-713-523-9803 or by e-mail to 10273@pslweb.com. You
can also call PsL 1-877-724-4600 (toll free in the US) or 1-713-610-1432 between the hours of 8:30 am
and 5:00 pm CST Monday-Friday, except holidays. You can send credit card orders via postal mail to PsL
at P.O. Box 35705, Houston, TX 77235 USA. Please be sure to include a completed credit card order
form (below) with your order.

Note: this ordering information is for the English version of WinZip. All orders are subject to the WinZip
License Agreement. Prices guaranteed through December 1999.

Nico Mak Computing, Inc. cannot be reached at the numbers above. These numbers are
for PsL, a third-party service that only takes credit card orders.

Any questions about the status of the shipment of an order, refunds, registration options, product details,
technical support, volume discounts, dealer pricing, site licenses, etc., should be directed to Nico Mak
Computing. You can send e-mail to help@winzip.com; our goal is to respond to all e-mail inquiries within
one business day. You can also send postal mail to Nico Mak Computing, P.O. Box 540, Mansfield, CT
06268, USA.

WinZip Single Copy _at $29each=
WinZip Site Licenses:

2to9 computers: _ at $22 each =

10to 24 computers: _ at $17 each =

25to49 computers: _ at $14 each =

50 to 99 computers: _ at $10 each =

100 to 199 computers: _ at $7 each =

200 to 499 computers: _ at $6 each =

500 to 999 computers: at $4 each =

Connecticut Residents add 6% sales tax:

Total payment:
Date:

Credit Card: [ ]MasterCard [ ]VISA [ TAMEX [ 1]
Discover

Credit Card #:
Expiration Date:
Name On Card:

Signature:

Name:

Company:
Billing Address:
City, State, Zip:

Country:

Day Phone:

E-Mail address:
How did you hear about
WinZip?




Purchase Orders

Purchase orders (net 30 days) are accepted from government and accredited educational institutions and
major corporations, provided that they are submitted on purchase order forms with a purchase order
number. Please be sure to include the standard WinZip order form with your purchase order, and send it
to Nico Mak Computing, P.O. Box 540, Mansfield, CT 06268 USA, or fax it to 1-860-429-3542.



CompuServe SWREG Ordering

Use the CompuServe command GO SWREG and follow the menus to register one of the product IDs
listed in the table below.

Detailed instructions for CompuServe for Windows users: select Go from the Access menu (WinCIM
users, select Go from the Services menu), then type SWREG. Double click on “Register Software” in the
Shareware Registration box. After viewing the Registration Agreement, click on Proceed, then select
your Geographic Region. Double click on ID # in the Register Shareware box and enter one of the

following IDs:

ID Product Price

402 Single Copy $29

4628 2-9 computer site license $22 each computer
4629 10-24 computer site license $17 each computer
4630 25-49 computer site license $14 each computer
4631 50 computer site license $10 each computer

Now double click on “Display Selected Titles” and then double click on the appropriate entry. Click on
Description to see a description of WinZip. You can now click the Register button to fill in your order
information. You will receive a confirmation by e-mail within one business day.



Ordering Options Outside the USA and Canada

In addition to the aforementioned registration options you can contact the following distributors for local
registration and support. Dealer prices may vary.

German Users: For a German language version of WinZip, please contact Top Systems, GmbH,
Sonnenbergstr. 4 D-71065 Sindelfingen, Germany, phone: +49-(0)-2834-9332-0, Web: www.winzip.de, e-
mail: support@winzip.de. For online sales, see the web page http://www.winzip.com/order_german.cgi.

French Users: For a French language version of WinZip, please contact AB Soft, Park Burospace #14,
91572 Bievres Cedex, France, phone: 33-1-69-33-70-00. For online sales, see the web page
http://www.winzip.com/order french.cgi.

Japanese Users: For a version of WinZip that includes a Japanese Help file, contact P&A Inc. No.3 Hoko
Bldg. 6F 2-29-13 Akebono, Tachikawa, Tokyo 190-0012 Japan, phone: (042) 525-9501, fax: (042) 525-
9502, Web: www.pandasw.com www.panda.co.jp, e-mail: sales@panda.co.jp or PAF02461 on NiftyServe.
For online sales, see the web page http://www.winzip.com/order_japan.cgi.

Other International Users: You can order directly from Nico Mak Computing, Inc, as described above, or
can contact ASi for the name of the nearest ASi reseller at 1-937-847-2374 (phone), 1-937-847-2375
(fax), or info@asizip.com (e-mail).

If you purchase WinZip directly from Nico Mak Computing, be sure to contact Nico Mak Computing for
support, not your local reseller.



Support and Questions

To check whether you have the most recent version of WinZip, please check the WinZip home page at
http://www.winzip.com.

Please see the section titled Frequently Asked Questions for answers to common questions.

Technical support is available at no charge as described below. The best way to report problems is with
the support forms available from the “Support” link on the WinZip home page (http://www.winzip.com).
You can also send e-mail to help@winzip.com on the Internet or to 70056,241 on CompuServe, send
postal mail to Nico Mak Computing, Inc., P.O. Box 540, Mansfield CT 06268, or post a message in the
“WinZip Support” section in the GO WINZIP area on CompuServe.

When reporting problems, please include the following information:

1.
2.
3.

Is the problem reproducible? If so, how?
What version of Windows are you running? For example, Windows 95, Windows NT 4.0, etc.

What version of WinZip are you running? Select About WinZip from the WinZip Help pull-down
menu. Please include the entire “version” line in your problem report.

If a dialog box with an error message was displayed, please include the full text of the dialog
box, including the text in the title bar.

If the problem involves an external program like LHA.EXE or SCAN.EXE, what version of the
failing program are you using? Please see the section titled System Requirements for minimum
version numbers for these programs.

Note: You can press F1 at any time while WinZip is active for context sensitive help.
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Drag and Drop Interface
The Drag and Drop Interface provides a convenient way to:

e Open an archive with WinZip
e Add, freshen, move, and update files in an archive
e  Extract, view, or print files from an archive

e Use an archive in another application
For details, click on the appropriate topic above.

Related Topics:
Drop Dialog Box
Add and Drop Dialog Box Options



Opening an Archive with the Drag and Drop Interface

To open an archive with the Drag and Drop Interface
1. Click on an archive in My Computer or the Windows Explorer.
2. While holding down the mouse button, move (drag) the mouse pointer over a WinZip window.
3. Release the mouse button. This opens the selected archive.

Note: You can also open archives by double clicking on the name of an archive in My Computer or the
Windows Explorer, by clicking on the Open button in the main WinZip window, or by selecting Open from
the File pull-down menu.



Adding a File to an Archive with the Drag and Drop Interface

To add a file to an archive with the Drag and Drop Interface
1. Click on a file in My Computer or the Windows Explorer.
2. While holding down the mouse button, drag (move) the mouse pointer to any of the following:
e A WinZip window
e The WinZip shortcut on your desktop
e AZipfile listed in My Computer or the Windows Explorer
e Ashortcut to a Zip file
3. Release the mouse button to drop the file.
Notes:

To add multiple files to an archive using the Drag and Drop Interface, select the desired files in My
Computer or the Windows Explorer before dragging them to WinZip.

You cannot use the Drag and Drop Interface to add files with an extension of ZIP, LZH, ARJ, or ARC; use
the Add dialog box instead.

There are other ways to add files to an archive:
e The Add dialog box

e The Explorer or File Manager interface.



Extracting, Viewing, and Printing Files in an Archive with the
Drag and Drop Interface

You can drag and drop files from WinZip to other applications, My Computer or the Windows Explorer,
the desktop, printers, and to shortcuts. If you drop files on a folder listed in My Computer or the Windows
Explorer, the files are extracted to that folder. If you drop files on the desktop, the files are extracted to
the desktop folder. If you drop files onto a printer, the files are printed. If you drop files on another
application or on a shortcut, the files are extracted to the temp folder before the files are passed to the
application, and are removed when the archive is closed.

Important:

Different applications handle dropped files in different ways. For example, when you drop a file on the
Wordpad application distributed as part of Windows it will embed the file as an OLE object, but when you
drop a file on the Notepad application distributed as part of Windows it will open the file. You may need
to experiment with drag and drop to understand how each application reacts to a file dropped on it.

Notes:

You can also extract files by pressing the Extract push button or using the Extract entry on the Actions
pull-down menu.

You can move or copy files from one archive to another by opening multiple copies of WinZip, one for
each archive, and dragging files from one to the other.



Dropping an Archive on Another Application

You can use the drag and drop interface to drop the open archive on another application as follows:
1. Click on the WinZip status line.

2. While holding down the mouse button, drag (move) the mouse pointer to a window that accepts
dropped files (the mouse pointer will indicate whether the target window accepts dropped files).

3. Release the mouse button to drop the open archive.
Examples of when this is useful include:
e Attaching an archive to a mail message when using a mail program like Microsoft Mail.

¢ Adding an archive to a disk image when using Winlmage, a shareware disk image utility available
on CompuServe and many BBSs.

Note: If no archive is open you cannot drag and drop from the WinZip status line.



Drop Dialog Box

The Drop dialog box is displayed when you use the Drag and Drop Interface to add files to an archive.
The Drop dialog box lets you change the name of the open archive in one of two ways:
e Type the name of the archive in the Add to archive edit field.

¢ Click on the New... or Open... buttons to activate the standard New and Open dialog boxes,
respectively.
These shortcuts provide a quick way to add files to a different archive without going through the File pull-
down menu.

See the section titled Add and Drop Dialog Box Options for a description of the options available in this
dialog box.



Explorer Interface

You can zip and unzip files without leaving My Computer or the Windows Explorer, as described in the

section Windows 95/98/NT/NT Shell Integration Examples. You can also open archives by dragging
them from My Computer or the Windows Explorer to a WinZip window, and can add files to an archive by
dragging them from My Computer or the Windows Explorer to a WinZip window as described in the

section Drag and Drop Interface.

Related Topics:

System (Configuration)
Explorer Add Dialog Box



Explorer Configuration Dialog Box

This dialog box is displayed during the WinZip installation process. The following choices are available:

The Associate WinZip With archives checkbox determines whether you will be able to double
click on archives in My Computer or the Windows Explorer to open them. If this option is
checked, the following extensions will be associated with WinZip: ZIP, LZH, ARJ, ARC, CAB,
TAR, TGZ, TAZ, GZ, Z, UU, UUE, XXE, B64, HQX, BHX, and MIM. If this option is not checked,
WinZip will ensure it is not associated with these extensions. See the section titled Windows
Associations for more information on associations.

The Explorer Shell extension checkbox determines whether the WinZip Explorer context menus
are enabled, and whether you can use drag and drop to zip and unzip without leaving My
Computer or the Windows Explorer.

The Non-cascaded WinZip context menu items checkbox controls whether WinZip Explorer
context menu items are displayed in the main context menu or in a sub-menu.

The Display icons on context menus checkbox determines whether a small WinZip icon is
displayed to the right of the WinZip Explorer context menu items.

If the Include WinZip in Start menu checkbox is checked, WinZip is automatically added to the
Taskbar Start menu. Uncheck this option to remove WinZip from the Start menu.

If the Include WinZip on desktop checkbox is checked, a shortcut to WinZip is added to the
desktop. Uncheck this option to remove the WinZip shortcut from the desktop.



Explorer Add Dialog Box
The Explorer Add dialog box is displayed when you use the Add Files To Zip entry in the My Computer
or the Windows Explorer context menus.
This dialog box lets you change the name of the open archive in one of two ways:
e Type the name of the archive in the Add to archive edit field.

e Click on the New... or Open... buttons to activate the standard New and Open dialog boxes,
respectively.

These shortcuts provide a quick way to add files to a different archive without going through the File pull-
down menu.

See the section titled Adding Files to an Archive for a description of the options available in this dialog
box.




File Manager Interface

WinZip's File Manager interface lets you open archives by double clicking in the File Manager, access
WinZip through a pull-down menu to the File Manager, and automatically start and stop WinZip along with
the File Manager.

You can also open archives by dragging them from the File Manager to a WinZip window, and can add
files to an archive by dragging them from the File Manager to a WinZip window as described in the
section Drag and Drop Interface.

Note: the File Manager Interface feature has been retained from the 16-bit version of WinZip for the
convenience of Windows 95/98/NT users who prefer to use File Manager. Most Windows 95/98/NT
users will not need this feature.

Related Topics:

System (Configuration)

The WinZip File Manager Menu
File Manager Add Dialog Box



The WinZip File Manager Menu

The optional WinZip menu in the File Manager provides the following choices:

e The Open Archive entry will open the currently selected archive. If a WinZip task was started by
the File Manager that task will open the archive; otherwise a new WinZip task will be started to
open the archive.

e The Add Files To Archive entry adds the selected files to an archive. If a WinZip task was
started by the File Manager that task will handle your Add request; otherwise a new WinZip task
will be started. In both cases you will have the opportunity to specify which archive should
receive the files you are adding.

e The Configure entry activates the Configuration | System Dialog Box.
e The About entry displays a copyright notice.



File Manager Add Dialog Box

The File Manager Add dialog box is displayed when you use the Add Files To Archive entry in the File
Manager's WinZip pull-down menu. For information on enabling and disabling this menu entry see the

section titled System (Configuration).
This dialog box lets you change the name of the open archive in one of two ways:
e Type the name of the archive in the Add to archive edit field.

e Click on the New... or Open... buttons to activate the standard New and Open dialog boxes,
respectively.

These shortcuts provide a quick way to add files to a different archive without going through the File pull-
down menu.

See the section titled Adding Files to an Archive for a description of the options available in this dialog
box.




Menu Tree

File Menu
New Archive...

Open Archive...
Favorite Zip Folders...
Close Archive
Properties...

Create Shortcut
Move Archive...
Copy Archive...
Rename Archive...
Delete Archive...
Print...

Wizard

Mail Archive...

Exit

Actions Menu
Add...

Delete...

Extract...

View...

Select All

Invert Selection
Virus Scan

Make .EXE File
Uuencode

Test

Comment...
CheckOut...

Install...

Options Menu
Configuration...
Password...

Sort

Reuse WinZip Windows
Save Settings on Exit
Save Settings Now
Set Installation Defaults...
View Last Output...
Help Menu
Contents

Brief Tutorial

Hints and Tips

Tip of the Day
Search for Help on...

Open a new archive

Open an existing archive

Open the Favorite Zip Folder dialog

Close the open archive

Display the open archive's properties

Add a shortcut to the open archive to the desktop
Move the open archive to a different drive or folder
Copy the open archive to a different drive or folder
Change the file name of the open archive

Delete the open archive

Print a listing of the open archive's contents
Switch to the Wizard interface

E-mail the open archive

Close WinZip

Add files to the open archive

Delete files from the open archive

Extract files from the open archive

View files in the open archive

Select all files in the open archive

Reverse selected and unselected file status in the open archive
Run a virus scan program against archive contents
Create a self-extracting archive

UUencode the open archive

Test integrity of the open archive

View, add, edit, or delete a Zip comment

Examine and/or run programs in the open archive
Install the software contained in the open archive

Change WinZip settings

Set password for subsequent archive operations

Specify sort order for list of files in archive

Don't open new windows when WinZip is started

Control whether options are saved when WinZip is closed
Save configuration settings immediately

Set many options to original installation defaults

View output from the last command issued by WinZip

Start Help and display topics in WinZip help file
Display brief WinZip tutorial

Display hints and tips

Open the Tip of the Day window

Open search dialog box for WinZip help



How to Use Help Display instructions for using help system

Frequently Asked Questions Open this Help File to that topic

Enter Registration Code Access the dialog for entering registration information
Ordering Information Display order form

License Agreement Display license agreement

WinZip Home Page Start your default browser and visit the WinZip web site
About WinZip... Display copyright notice

The File Menu

The following entries are available on the File menu:

The New Archive menu entry creates new archives.
The Open Archive menu entry opens existing archives.
The Favorite Zip Folders menu entry displays a list of Zip files in your favorite Zip folders.

The Close Archive menu entry closes the currently open archive. This menu entry is included
primarily for completeness, since the New and Open menu entries automatically close the open
archive.

The Properties menu entry displays a dialog box with the archive format, full flename, actual
archive size, number of files in the archive, average compression ratio, and the date and time that
the archive was last updated.

The Create Shortcut menu entry creates a shortcut to the open archive on your desktop.

The Move Archive, Copy Archive, Rename Archive, and Delete Archive menu entries facilitate
Archive Management.
The Print menu entry prints a listing of the files in the archive.

The Wizard menu entry activates the WinZip Wizard.

The Mail Archive menu entry, available only if your system is configured to use MAPI (the
standard Mail Application Program Interface), makes it easy to mail an archive.

The Exit menu entry closes WinZip.
The last four archives you opened can be re-opened directly from the File menu.



Creating a New Archive

To create a new archive, select New Archive from the WinZip File pull-down menu. This activates the
New Archive dialog box. Type the name of the archive you want to create. Do not enter the names of
the files you want to compress. This dialog box works almost like the standard Windows Open dialog
box. You can use the Create in combo box to choose the drive and folder where the archive will be
created. For example, to create an archive on your floppy drive, select “3 V2 Floppy” in the Create in
combo box. The names of any existing archives on the selected drive and folder will be listed to help you
choose a name that is not already in use.

Check the Add dialog check box in the New Archive dialog box if you would like to automatically activate
the Add dialog box after the new archive is opened.

To list self-extracting archives in the New and Open dialog boxes, select the “archives and exe files” entry
in the Files of type combo box. Note: When self-extracting archives are listed in the open dialog box, all
EXE and COM files in the selected folder will be listed, even if they are not self-extracting archives.
WinZip is not able to check whether a file is a self-extracting archive until it is opened.

See the section File Type Filters for details on the File Type filters in the Files of type combo box.



Opening an Existing Archive

To open an existing archive, select Open Archive from the WinZip File pull-down menu. This activates
the standard Open Archive dialog box. Then select the archive you want to open in the Open dialog box.
Opening an archive is just like opening a document in Write or a spreadsheet in Excel; the only difference
is that you open an archive instead of a document or spreadsheet. Use the Create in combo box to
select the appropriate folder and click on the archive in the list below. Press the OK button when you
have made your selection.

To list self-extracting archives in the New and Open dialog boxes, select the “archives and .exe files”
entry in the Files of type combo box. Note: when self-extracting archives are listed in the open dialog
box, all EXE and COM files in the selected folder will be listed, even if they are not self-extracting
archives. WinZip is not able to check whether a file is a self-extracting archive until it is opened.

See the section Eile Type Filters for details on the File Type filters in the Files of type combo box.



Favorite Zip Folders

About Favorite Zip Folders:

The “Favorite Zip Folders” feature organizes Zip files into one convenient list that is sorted by date,
making it easier to locate all Zip files, regardless of where they came from or where they are stored. For
example: by default, CompuServe downloads go into the c:\cserve\download folder, while AOL downloads
go into the c:\aol\download folder. Unlike the standard File->Open Archive dialog box, the Favorite Zip
Folders dialog box treats the contents of multiple folders as though they were one folder.

Using the Favorite Zip Folders Dialog Box

Click the Favorites button on the toolbar or select Favorite Zip Folders from the File pull-down menu to
activate this facility. When you open the Favorite Zip Files dialog box, all Zip files in your Favorite Zip
Folders are listed by date, with the most recently modified files listed first.

The first time you activate the Favorite Zip Folders dialog box, it will automatically search your computer
for folders containing or likely to contain Zip files. You can easily add and remove folders from your list of
“Favorite Zip Folders” using the Options button.

To open a Zip file, select it and click Open, or simply double click on the Zip file.

Click Search to search for Zip files in other folders. The results of your search will temporarily replace
the list of files in the Favorite Zip Folders dialog box.



Viewing Archive Properties

The Properties menu entry in the WinZip File menu displays a dialog box with the archive format, full
filename, actual archive size (in bytes), number of files in the archive, average compression ratio, and the
date and time that the archive was last updated.



Archive Management

The Copy Archive, Move Archive, Rename Archive, and Delete Archive entries in the File menu
facilitate archive management.

Copy Archive copies the open archive to another folder or disk. The Copy dialog box is displayed so
you can choose the destination for the copy operation.

Move Archive moves the open archive to another folder or disk. The Move dialog box is displayed so
you can choose the destination for the move operation.

Rename Archive gives you an opportunity to change the file name of the open archive. The Rename
dialog box lets you change the open archive's file name but not the filename extension (file type). Simply
type the new file name and press the OK button.

Delete Archive deletes the open archive. A confirmation dialog is displayed to avoid accidental deletion.
If you choose to continue the archive is closed and deleted.



Printing a List of the Files in an Archive

To print the list of files shown in the main WinZip window, select Print from the File pull-down menu. The
columns shown in the WinZip window will be printed. The standard Print dialog box lets you choose
which printer should be used, how many copies are printed, whether to print in landscape or portrait
mode, etc.

Hint: you can change the content of the printed file listing by changing the columns that are shown in the
WinZip window. To do this, cancel the print request, make the desired column changes in the

Configuration | View Dialog Box, and select Print again.

How to Print a List of the Files in an Archive to a Text File on Disk

You can also use the Print item on the File pull-down menu to save the list of files in an archive in a text
file on disk. You first may need to set up a “printer port” you can use to create such print image disk
files, however.

To set up such a printer port, perform the following steps:
1. From the Start menu, click Settings, then Printer.
2. Double-click Add Printer. The Add Printer Wizard will start. Click Next to advance to the next panel.

3. Check the Local printer option button, and click Next. Windows may display a small window and
progress meter while it builds a printer information database. If you see such a window, wait until the
process completes.

4. You should now see a panel with two lists: one of printer manufacturers and another of printers. Scroll
down the list of Manufacturers until you see the item Generic, and then click this item. The Printers
list should automatically change to have the entry “Generic/Text Only”. Click Next.

5. Windows then may need to load a driver, either from files already on your hard disk, or from your
Windows distribution CD-ROM or diskettes. Follow the instructions for doing so. If instead you see a
panel that says “A driver is already installed for this printer ...”, check the Keep existing driver
option button, and click Next.

6. Inthe next panel, select "File" from the Available ports window, and click Next.

7. In the next panel, you can use the Windows-generated name for the printer, or you can enter a more
descriptive name such as “Print to Disk File” in the Printer name field, and then click Next.

8. In the next panel, check the option button labeled Yes in response to the question “Would you like to
print a test page?”, and then click Finish.

9. Windows will prepare a test page, and then display a “Print To File” dialog. You can use this dialog to
specify the file and folder into which the print output should go.

10. After printing is complete, there should be a file containing the print output in the location you
specified. Using a utility such as Notepad, check the output to make sure it looks all right. Windows
will ask you if the test page printed correctly. Assuming it did so, click Yes.

From now on, when you print to your new “Print to Disk File” printer, the output will go to a plain text file
on your disk, and you can then use a utility such as Notepad to view and edit the output.

In WinZip, to save an archive listing to a text file, select Print from WinZip's File menu. When the Print
dialog appears, click the arrow on the Name drop down list, select your “Print to Disk File” printer, and
click OK. Windows will ask for a file name for your text file and then WinZip will direct the listing to the
text file.

Windows tip: you can use your new Print to Disk File printer to send print output to disk from almost any
Windows application, as long as the application allows you to select a printer when you produce print
output. Just select your “Print to Disk File” printer as the destination for the output.






Adding Files to an Archive

New users: for introductory information, please see the section Brief Tutorial - Adding Files to an Archive.

This section describes the Add dialog box. There are other ways to add files to an archive:

The Drag and Drop interface
The Explorer or File Manager interface.

The Add dialog box:

To open the Add dialog box, click on the Add push button or select the Add entry from the Actions pull-
down menu to bring up the Add dialog box.

You can select the files you want to add in several ways:

Click on the desired files in the list near the top of the Add dialog box. You can select multiple files
using normal Windows file selection conventions (for example, hold down the Shift key while
clicking to select multiple files). Then press the Add button.

Type the name(s) of the files you want to add. If you specify multiple flenames, each filename
must be enclosed in double quotes. Then press the Add button.

To add files with wildcards (for example, “*.doc” to add all files with an extension of .doc), type
the filename with wildcards in the File name edit field, then press the Add with wildcards button.
Standard wildcards are accepted.

See the section titled Add and Drop Dialog Box Options for a description of the options available in this
dialog box.



Add and Drop Dialog Box Options

The Add and Drop dialog boxes include these options:

Note:

The Action drop down list provides four choices: Add, Freshen, Move, and Update. The Add
option causes WinZip to add all specified files to the archive. The Freshen option causes WinZip
to update files already in the archive that match the specified files. The Update option is the
same as Freshen, but adds any specified files that are not already in the archive. The Move
option works the same as Add, except that once the specified files have been added to the
archive they are deleted from disk.

The Compression drop down list determines the compression method. Faster compression
options usually result in larger archives.

The Multiple disk spanning drop down list controls how WinZip handles disk-full conditions
while creating a new Zip file on removable media, such as a diskette. This drop down list is
disabled (not available) unless you are working with a new Zip file on removable media. When
this drop down list is available, you can select from one of three available values:

Automatic will automatically prompt for another diskette when the diskette on which you are
creating a Zip file is full.

Automatic + Wipe First Disk Prompt is the same as Automatic, but will give you the opportunity to
erase any files on the first diskette.

No Spanning results in a “disk full” error message if the size of the Zip file exceeds the space
available on the removable diskette.

The Include subfolders check box determines whether WinZip traverses all folders underneath
the specified folder when looking for files to add. This provides an easy way to backup all files
underneath the folder containing the specified file.

Note: to restore a branch of a folder added with the Include subfolders option, be sure to select
the Use folder names check box in the Extract dialog box.

The Save extra folder info causes WinZip to store any folder path information specified in the
Add files edit field.

The Password button will password protect (encrypt) the file(s) you are adding. Please be sure
to read the information in the section titled Password Security before using passwords.

The Add with wildcards button adds the files specified in the File name field. (In Windows
“wildcards” are the asterisk and question mark characters. These let you specify multiple files at
once, for example, “*.Txt” refers to all files with a file type of “Txt”.)

The Store filenames in DOS 8.3 format checkbox causes WinZip to store the short 8.3 MS-DOS
compatible form of any long filenames. “8.3” refers to the maximum of 8 characters in the
filename portion of the name and 3 characters in the extension, for example, “12345678.123”.

The Attributes section controls WinZip's handling of file attributes. Attributes are an advanced
subject; you do not need to understand attributes for normal WinZip operation. If you are
interested but not familiar with read-only, hidden, system, and archive attributes, please refer to
your Windows documentation. This section contains three options:

The Include only if archive attribute is set option excludes files whose archive attribute is not
set.

The Reset archive attribute turns off a file's archive attribute after the file is added to the Zip file.

The Include system and hidden files option causes WinZip to add files with the system and
hidden attributes. Normally files with these attributes are included.



The Include only if archive attribute is set checkbox will exclude files whose archive attribute is not set.
This option does not control which folders are searched when the Include subfolders option is selected.



Deleting Files from an Archive

Select Delete from the Actions menu to activate the Delete dialog box. There are two ways to delete
files from an archive:

e Select entries in the list box, then select Delete from the Actions pull-down menu.

¢ Select Delete from the Actions pull-down menu to bring up the Delete dialog box. You can then
specify the files you want to delete (standard Windows wildcards are accepted, so you could use
“*.doc” to delete all .doc files).

Notes:
These operations cannot be undone.

To delete an entire archive select Delete from the Actions pull-down menu to bring up the Delete dialog
box. Then select the Entire archive option button and click on the Delete push button. Alternatively,
you can select Delete archive from the File menu.



Extracting Files from an Archive
New users: For introductory information, please see the section Brief Tutorial - Extracting Files.

This section describes the Extract dialog box. There are other ways to extract files from an archive:

The Drag and Drop interface
Directly from My Computer or the Windows Explorer, as described in the section Windows
95/98/NT Shell Integration Examples.

If a Zip file contains a “setup” or “install” program, you can use the Install Feature to
automatically extract the files, run the installation program, and clean up temporary files.

The Extract dialog box:

Use the Extract button on the toolbar or select Extract from the Actions menu to display the Extract
dialog box. Use the Extract dialog box to extract or “unzip” files from the open archive to your disk.

WinZip extracts files from the archive to the folder specified in the Extract to field. You can specify this
folder in one of four ways:

Select a folder and drive in the Folders/Drives list boxes.
Type a folder name in the Extract to field.

Pull down the Extract to combo box and select a folder from the list of previous Extract to
folders.

Press the New folder... button and create a folder.

The Extract dialog box provides the following options:

Note:

The Selected files option button instructs WinZip to extract only files that are selected in the main
WinZip window. You can use conventional file selection methods to choose files. This option is
disabled if no files are selected.

The All files option button instructs WinZip to extract all files from the archive.

The Files option button and edit field allow you to specify which files are extracted using
filenames (standard Windows wildcards are accepted, so you could use “*.doc” to extract all .doc
files)

The Overwrite existing files check box determines whether you are prompted before existing
files are overwritten with files from the archive.

The Skip older files check box determines whether WinZip skips (does not extract) existing files
when the date/time stamps of the file in the archive is older than the file on disk.

The Use folder names check box determines whether WinZip will use folder names (also known
as path names) stored in the archive. You will probably want to check this option for most extract
operations. If this option is checked any folder names stored in the archive will be appended to
the Extract to folder when appropriate. If this option is not checked all files will be extracted to
the same folder, regardless of any folder names in the archive.

For example, assuming the Extract to folder is “c:\temp", the file “mydir\filename” will be
extracted to the folder “c:\temp\mydir” if the Use folder names option is checked, or the folder
“c:\temp” if the option is not checked.

The New folder button activates the Create Folder dialog box. Note that you can extract files
and create a folder without this dialog box: simply type the name of the new folder in the Extract
to field of the Extract dialog box and press the Extract button.

You can change the default Extract to folder using the Configuration | Folders dialog box.



Viewing Files in an Archive

You can view files in an archive in several ways:

e With the View button in the toolbar or the View entry in the Actions pull-down menu. This
activates the View Dialog Box.

e With the Drag and Drop interface.
e With the features described in the section titled CheckOut Feature.

¢ Most files can be viewed by double clicking on the file name in the main window's list box, as
described in the section titled Double Clicking



View Dialog Box

When you push the View button in the toolbar or choose the View entry in the Actions menu the View
dialog box is displayed. This dialog gives you a choice of viewing the selected file(s) in one of three
ways:
e Using the associated program. The associated program is listed in parentheses. This method
is similar to double clicking on a file in the main window (unless the file is executable; in which
case the executable file is opened with the program specified in the Default association field in

the Configuration | Program Locations dialog box).

e Using the built-in internal ASCII text viewer. Multiple files can be viewed in one view operation
using this viewer.

e With any viewer available on your system. You must specify the name of the viewer.



Built-In Viewer

The built-in ASCII text viewer can be used to view text files in an archive, the results of the last operation
using the View last output entry in the Options pull-down menu, and system configuration information
using the System Info button in the About dialog box..

Unlike most dialog boxes, the viewer window can be resized and maximized.

Click on the Clipboard Copy push button to copy selected text to the system clipboard. If no text is
selected all the text is copied to the clipboard.

Note: The viewer is limited to plain ASCII text, just like the Windows Notepad application.



Select All and Invert Selection

The Select all entry in the Actions menu selects all the files in the main window's list box. Invert
Selection deselects the currently selected files and selects the currently unselected files. Selected files
can then be easily deleted, extracted, or viewed.



Virus Scan

Use the Virus Scan entry in the Actions pull-down menu to determine whether files in the archive
contain viruses. To use this feature a virus scanner must be configured, as described in the section titled
Virus Scanner Configuration. Note that the CheckOut feature also provides optional virus scanning.

The Virus Scan operation performs the following actions:

1.

ok N

Creates a temporary folder

Extracts all files in the current Zip to the temporary folder

Runs the virus scanner against files in the temporary folder

Deletes all files in the temporary folder and removes the temporary folder
Displays the results of the scan operation in the View window



Creating a Self-Extracting Archive

Use the Make .Exe File entry in the Actions menu to convert the open archive to a self-extracting
archive. Self-extracting archives have an extension of .EXE, and can be run as commands. When a
self-extracting archive is run, the files in the archive are automatically extracted. This is convenient,
because the end user does not need an unzip program (like WinZip) to extract files from these self-
extracting archives.

When working with a Zip file, this operation normally runs WinZip Self-Extractor Personal Edition, but you
can also configure WinZip to use another program. When working with an LZH file, this operation runs
the external LHA program with the s option. When working with an ARJ file, this operation runs the
external ARJ program with the y option. For details on configuring WinZip to work with external

programs, see the sections titled System Requirements and Installing Optional External Programs.
Notes:

If the first file in a self-extracting LZH file is named “!” (i.e. an exclamation mark is the only character in
the filename) this file will be displayed when the self-extracting executable is run. To ensure that this file
is the first file in the archive create a new LZH file, then add the “!” file (do not add other files in this step),
and finally add the remaining files.



UUencoding an Archive

Use the UUencode entry in the Actions pull-down menu to UUencode the open archive. The
UUencoded file can be sent across mail systems that do not support binary e-mail. For further details on
UUencoded, XXencoded, BinHex, and MIME files, refer to that section of this help file.




Testing an Archive

Use the Test entry in the Actions pull-down menu to test the integrity of the open archive. A dialog box
is displayed with the results of the test operation.

Press the Esc key during the Test operation to terminate the integrity test.



Comment

Use the Comment entry in the Actions pull-down menu to activate the Comment dialog box. This
feature is available for Zip files only.

A Comment is optional text information that embedded in a Zip archive. It can be viewed, created,
edited, or deleted using the Comment dialog box. Simply key in your text or use any common Windows
cut, copy, or paste methods.

Use the Close button to close this dialog.
Click on Save to save any comment or edits you've made.
Clear deletes any comment.

Clicking on Font allows you to specify a new display font. It does not affect the archive comment, but is
retained as your preference for viewing comments in future sessions.



CheckOut Feature

The CheckOut feature makes it easy to examine and/or run files in an archive. It creates a temporary
folder, extracts all files from the archive into the folder, and opens a “My Computer"-style window showing
files in the folder. Double click any item in the window to perform the action normally associated with the
document or program (associations are described in the section titled Windows Associations). WinZip
will optionally close the window and delete the temporary folder (and the extracted files) when you close
the archive or close WinZip.

CheckOut Dialog Box

Use the CheckOut toolbar button or the CheckOut entry in the Actions pull-down menu to activate the
CheckOut dialog box. This dialog box lets you configure these aspects of the operation:

e Use the Folder edit field to specify the temporary CheckOut folder name. The folder will be
created if it does not already exist. The suggested folder depends on the setting of the
CheckOut base folder in the Configuration | Folders dialog box.

e Use the Group name edit field to specify the name to use for the CheckOut window.

¢ Use the Maximum Icons edit field to specify the maximum number of items to be placed in the
CheckOut window.

¢ The Create icons for programs and documents only check box lets you control whether
WinZip creates icons for all files in the archive or only for the specified files. When this option is
selected, icons are created for executable files and files with associations. Icons are also
created for any files with names starting with “read” (in order to catch files with names like
“readme.1st", “read.me", etc.).

e The Run virus scanner check box lets you specify whether WinZip will run a virus scanner on
the files in the archive. This option is disabled unless a virus scan utility is installed in the

Configuration | Program Locations dialog box.
Operations performed by the CheckOut feature:
When you click on the OK button in the CheckOut dialog box, WinZip performs the following operations:

1. If the specified folder does not already exist, WinZip will create it. If it already exists and
contains files, WinZip will delete the files (after asking your permission, of course). This ensures
that the folder will contain only files from the current archive.

2. The “CheckOut window” is actually a second folder, located in \Windows\Start Menu\Programs,
that contains shortcuts to the extracted files. If a folder with the specified name already exists,
WinZip will delete it after getting your permission. This ensures that the folder will contain only
icons for files in the current archive.

3. WinZip extracts files in the current archive to the specified folder.

4. If the Run virus scanner check box is selected your virus scanner is run against all files in the
specified folder. If the virus scan utility returns a non-zero error level, the CheckOut operation is
cancelled and messages from the scanner are displayed.

5. WinZip creates the CheckOut folder and window containing the appropriate icons.
Using the CheckOut window:

The window created by CheckOut is a My Computer-style view of the checkout folder and works like any
similar window. WinZip creates shortcuts in this folder for each extracted file so that you can use them
as follows:

¢ If afile is executable, double clicking on the icon runs the program.

¢ If afile has an association, double clicking on the icon loads the file in the associated program so
you can view the file.

e Otherwise, double clicking on the icon loads the file in the WinZip Default association program



specified in the Configuration | Program Locations dialog box.



Install Feature

WinZip's Install feature makes it easy to install software distributed in archives. The Install feature is only
available if an archive contains an “install” or “setup” program. The Install feature performs these
functions:

1. extracts all the files to a temporary folder

2. runs the Setup program

3. deletes the temporary installation folder and files
The Install Dialog Box:

Click the Install button on the toolbar or select Install from the Actions menu command to open the
Install dialog box.

Use the Minimize during install checkbox to control whether WinZip will be minimized while running the
install program.

Press the OK button to begin the installation.
Notes:

Self-extracting Windows archives are treated as a special case. If you have opened an self-extracting
Windows archive, the Install feature will simply run the self-extractor instead of extracting all the files to a
temporary folder, running the setup program, and deleting the temporary installation folder and files.

If the Install button is not displayed, but you recognize an installable file, you can use the CheckOut
Feature to try to install the software in the archive.

A pre-release Windows 95/98/NT version of the Install/Try/Uninstall feature is available from the WinZip
Home Page at http://www.winzip.com. This feature makes it possible to uninstall software installed with
WinZip’s Install feature.




Options

Use the Configuration entry in the Options pull-down menu to activate the Configuration dialog box.
This dialog box controls most WinZip settings.

Use the Password entry in the Options pull-down menu to activate the Password dialog box. This
dialog box lets you set a password for subsequent archive operations.

The Sort by entries in the Options pull-down menu let you specify whether the list of files in the archive
is sorted by name, path, type, size, compression ratio, compressed size, date, packed size, file attributes,
path, or whether the original archive order should be used. Note: You can also change the sort order by
clicking on the appropriate portion of the main list box header. For example, click on the word “Date” in
the header to sort by date. To reverse the sort order, click it again.

The Reuse WinZip windows entry in the Options pull-down menu determines whether a new window is
opened when you start WinZip by double-clicking in My Computer, the Windows Explorer, or the desktop.
When this entry is checked, an existing WinZip window is used. When this entry is not checked, a new
WinZip window is created. One advantage to reusing WinZip windows is that double clicking acts the
same as drag and drop, and you never accidentally wind up with multiple WinZip windows.

The Save settings on exit entry in the Options pull-down menu determines whether selected options
are automatically saved when WinZip is closed.

The Save settings now entry in the Options pull-down menu saves selected options immediately.

The Set Installation Defaults entry in the Options pull-down menu sets many configuration options and
folder names to the original installation defaults.

Use the View Last Output entry in the Options pull-down menu to display the results of the last WinZip
operation.



Configuration Dialog Box

Select Configuration from the Options menu to activate the Configuration dialog box. This dialog box
contains tabs that control most WinZip settings. Click on any tab title for further information on its content.

¢ The View tab controls the appearance of the main WinZip window.

e The Toolbar tab lets you customize the look and content of your WinZip toolbar.

e The Folders tab offers choices for start-up, extract, add, working, checkout, and temporary
folders.

e The System tab provides options for accessing WinZip through My Computer, the Windows
Explorer, and the File Manager.

e The Program Locations tab controls the default viewer, virus scanner, and optional archive
utilities.

e The Miscellaneous tab includes startup, “on top,” Smart DOC, and other general options.



View (Configuration)

Select the View tab in the from the Configuration Dialog Box to control these options:
Columns

Select the columns that you want to appear in the file listing. You may also use your mouse
cursor to resize and hide columns while in the WinZip window. Click on the Default button to
return the column selection selections and sizes to their original default values.

General

Allow all upper case file names - WinZip normally shows filenames the same way as Windows:
if the filename contains any lower case characters the filename is shown in mixed case.
Otherwise the first letter of the filename is shown in upper case and the remainder in lower case.
If this option is checked, filenames that contain no lower case characters will appear in all upper
case (rather than initial upper case).

Full row select - WinZip's default action is to use the Windows Explorer style of file selection,
requiring that the file name itself be clicked. This option allows you to click anywhere on the file's
row of information in order to select it.

Grid lines — Display grid lines to separate rows and columns in the main WinZip window.
Mouse selection

Normally the main WinZip window will automatically use the same mouse selection settings as
your Windows desktop. Should you need to change these settings for the main WinZip window,
you can use these fields to do so.

Note: these options are available only if you have version 4.71 or later of the Windows Common
Control library. This library is part of Windows 98, Microsoft Internet Explorer 4.0, and is available
as a separate download from from the Microsoft web site as described in the section Windows

Common Control Library.

Related Topics (other Configuration tabs):
Toolbar Folders System Program Locations Miscellaneous




Toolbar (Configuration)

Select the Toolbar tab from the Configuration Dialog Box to control these options:
¢ Use large toolbar buttons - use this option to display larger toolbar buttons.

¢ Show button text - use this option to display the name of the button under the button graphic on
the toolbar.

e Show tool tips - use this option to enable the display of brief, pop-up text describing a button's
function when your cursor pauses over a button.

¢ Flat toolbar buttons - use this option to give toolbar buttons a flat look instead of a 3D look.

e Use high color toolbar buttons when possible - use this option to control whether WinZip uses
high color toolbar buttons on systems configured to display more than 256 colors. This option is
only available when using large toolbar buttons.

Click Select Buttons to open the Select Buttons dialog box, which enables you to select and rearrange
the toolbar buttons.

Note: Some toolbar configuration options are available only if you have version 4.71 or later of the
Windows Common Control library. This library is part of Windows 98, Microsoft Internet Explorer 4.0, and
is available as a separate download from from the Microsoft web site as described in the section Windows

Common Control Library.

Related Topics (other Configuration tabs):

View Folders System Program Locations Miscellaneous



Select Buttons (Toolbar Configuration)

Click Select Buttons in the Toolbar tab in the Configuration Dialog Box to select and rearrange the
WinZip toolbar buttons. You can also right click on the toolbar itself and click on Select Buttons.

The left side of the Select Buttons dialog box shows the buttons and separators that are available for use.
The right side displays the toolbar arrangement in a vertical, top to bottom format, which is then
transformed into the horizontal, left to right format that WinZip uses.

Notes:

To Add a button, highlight the button in the left side of the dialog and click Add. It is easy to
move it to the preferred location. If desired, you can highlight the button above which you'd like to
insert the new button, first, and it will be placed in that position.

To Remove a button, highlight the button in the right side of the dialog, and click Remove.
To Rearrange toolbar buttons:

Select and drag a button to its new location; an arrow to the left of the button display will indicate
its placement.

Highlight a button and use the Move Up and Move Down buttons to move it to the desired
location.

To Reset WinZip to its original toolbar configuration, click the Reset button.

You can move buttons on the toolbar without using this dialog box: just press the Alt key on your
keyboard, and while holding down the Alt key, click on and drag a toolbar button from its current
location to the desired location.

You can remove buttons on the toolbar without using this dialog box: just press the Alt key on
your keyboard, and while holding down the Alt key, drag a toolbar button off the toolbar.

The separator at the end of the toolbar cannot be moved or removed.

This dialog box is only available if you have version 4.71 or later of the Windows Common
Control library. This library is part of Windows 98, Microsoft Internet Explorer 4.0, and is available
as a separate download from from the Microsoft web site as described in the section Windows

Common Control Library.

Related Topics (other Configuration tabs):

View Toolbar Folders System Program Locations Miscellaneous



Folders (Configuration)

Select the Folders tab from the Configuration Dialog Box to control these options:
Start-up folder

Unless you start WinZip by double clicking on an archive, WinZip will optionally change to a folder of your
choice when it starts up. Files in this folder are automatically displayed in the Open archive and New
archive dialog boxes. The following choices control which folder is used.

e System default - WinZip does not change folders, so the system default folder is in effect.
Usually this is the folder containing WINZIP.EXE or WINZIP32.EXE.

e Last open archive - WinZip changes to the folder containing the last open archive during your
last WinZip session, unless it is on your A: or B: drive.

¢ Folder - WinZip always changes to the specified folder.
Extract folder

These selections determine the default folder that WinZip automatically lists in the Extract to field in the
Extract dialog box. You can, of course, type over this default folder name or select a different folder from
the folder list.

e Open archive folder - WinZip lists the name of the folder containing the open archive in the
Extract to field. For example, if the archive c:\download\tools.zip is open, WinZip will list c:\
download.

e Last extract folder - WinZip will list the name of the folder you used during the last Extract
operation, unless it is on your A: or B: drive. This value is saved when you exit WinZip so you
can use it during your next WinZip session.

e Folder - WinZip always lists the specified folder. This value is saved when you exit WinZip so
you can use it during your next WinZip session.

Add folder
These selections determine the default folder when the Add dialog box is opened.
¢ Open archive folder - WinZip uses the folder containing the open archive.

e Last add folder - WinZip uses the folder you used during the last Add operation, unless it is on
your A: or B: drive. This value is saved when you exit WinZip so you can use it during your next
WinZip session.

¢ Folder - WinZip always uses the specified folder. This value is saved when you exit WinZip so
you can use it during your next WinZip session.

Working folder

If specified, temporary Zip files are created in this folder. If this option is not specified, temporary Zip files
are created in the folder containing the open Zip file. This option is particularly useful when you are
updating an archive and there is not enough room on the destination drive for both the original archive
and the updated archive. This is most likely to occur when you are working with removable media (e.g.
diskettes). You can tell WinZip to use this feature only when working with Zip files on removable media
by checking the Use for removable media only checkbox.

When using ARJ to create an archive WinZip specifies this folder name via the -w switch.
CheckOut base folder

If specified, WinZip uses this folder as the prefix for the default folder in the CheckOut dialog box. If this
field is left blank WinZip will instead use the folder containing the open archive.

Temp folder

This entry specifies the location for temporary files created by WinZip, including files created during the
View and Virus Scan operations. If you run out of disk space during a View or Scan operation, change the



Temp Folder to specify a drive and folder with sufficient free space.

Related Topics (other Configuration tabs):
View Toolbar System Program Locations Miscellaneous



System (Configuration)
Select the System tab in the from the Configuration Dialog Box to control these options:

General

The Associate WinZip with archives checkbox determines whether you will be able to double
click on archives in My Computer or the Windows Explorer to open them. If this option is
checked, the following extensions will be associated with WinZip: ZIP, LZH, ARJ, ARC, CAB,
TAR, TGZ, TAZ, GZ, Z, UU, UUE, XXE, B64, HQX, BHX, and MIM. If this option is not checked,
WinZip will ensure it is not associated with these extensions. See the section titled Windows
Assaociations for more information on associations.

If the Include WinZip in the start menu checkbox is selected, WinZip is automatically added to
the Taskbar Start menu. Uncheck this option to remove WinZip from the Start menu.

If the Include WinZip on the desktop checkbox is selected, a shortcut to WinZip is added to the
desktop. Uncheck this option to remove the WinZip shortcut from the desktop.

File Manager

The Include WinZip in File Manager menus checkbox determines whether the WinZip menu
entry is displayed on the File Manager menu bar.

The Start and stop WinZip with File Manager checkbox determines whether the File Manager
automatically starts WinZip when the File Manager is started and closes WinZip when the File
Manager is closed. This ensures that WinZip is always available for drag and drop operations
from the File Manager.

Explorer Shell Extension

The Use shell extension checkbox determines whether the WinZip Explorer context menus are
enabled, and whether you can use drag and drop to zip and unzip without leaving Explorer.

The Non-cascaded context menu items checkbox controls whether WinZip Explorer context
menu items are displayed in the main context menu or in a sub-menu.

The Display icons on context menus checkbox determines whether a small WinZip icon is
displayed to the right of the WinZip Explorer context menu items.

The Check for self-extracting CAB files checkboxes control whether WinZip’s right-click
context menu handler checks whether an .EXE file is a self-extracting CAB file. This check can
take a few moments (for example, 3 seconds on a floppy disk), so you can control whether the
check is done on local hard drives (fast), removable drives (slower), and/or other types of drives.

Related Topics (other Configuration tabs):

View Toolbar Folders Program Locations Miscellaneous



Program Locations (Configuration)

Select the Program Locations tab from the Configuration Dialog Box to specify the paths and filenames
for the optional external programs supported by WinZip. Note that these programs are not required for
most operations involving Zip files.

If you are installing WinZip and are not familiar with these programs you can just press the OK button to
continue the installation procedure.

External programs are not distributed with WinZip. For more information on these programs, including
availability and minimum version numbers, see the section titled System Requirements. For step by step
installation examples for external archivers see the section titled Installing Optional External Programs.
See the section titled Virus Scanner Configuration for information about that portion of the dialog box.

If a program is not installed on your system, just leave the corresponding field blank. Otherwise, fill in the
program name. The extension defaults to EXE. If no path is included for an entry, WinZip assumes that
the program is in a folder specified in your system's PATH.

The program specified as the Default association is used when viewing a file that does not have an
association. For additional information on associations, see the section titled Windows Associations.
The defaults for this field are:

e QuickView (quikview.exe), if you have installed this optional Windows component.

e SCCVAPILEXE, System Compatibility Corporation's “Outside In” file viewer, if it is found in a
folder specified by your system's PATH.

¢ NVIEWER.EXE, the Norton Desktop for Windows File Viewer, if it is found in a folder specified by
your system's PATH.

e WNFV.EXE, the PC Tools for Windows File Viewer, if it is found in a folder specified by your
system's PATH.

e NOTEPAD.EXE, the Windows Notepad program, if NVIEWER and WNFV are not found.
Almost any other file viewer or editor can be used.

The entry for the Optional virus scanner could have any of these values (the filenames shown are
examples):

Value Description

(blank) If the entry is blank, WinZip assumes that no virus scanner is installed
on your system.

SCANNER.EXE Just the filename is needed if the specified file (SCANNER.EXE, in
this example) is in a folder specified in your system's PATH.

C:\SCANNER\SCANNER.EXE The full drive, folder, and filename are required if the specified file

(SCANNER.EXE, in this example) is not in a folder specified in your
system's PATH. Note that C:\SCANNER is just an example, any
other folder can be used.

The ARJ, LHA, and ARC file formats require external programs to be available for them to be handled
using WinZip. You can type the names of these programs, or use the browse button [...] to locate them. If
they are not available on your system, leave the fields blank. They are only necessary if you use these
other archive formats and want WinZip to handle them for you.

See the section titled System Requirements for more information on version numbers and availability of
the external programs supported by WinZip.

Note: When WinZip is installed it will attempt to locate the default programs for each field in the folders
specified by your system's PATH. If it cannot find these programs, it will leave the corresponding edit
fields blank.

Related Topics (other Configuration tabs):
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Miscellaneous (Configuration)
Select the Miscellaneous tab from the Configuration Dialog Box to control these options:

Initialization

Next time start with the Wizard Interface - Whether WinZip should use the Wizard interface the
next time it is started.

Automatically show the Open Archive dialog box - Whether WinZip should automatically show
the Open Archive dialog box when you start WinZip.

Windows 95 Style Extract dialog box - This feature determines whether the Extract dialog box
contains a tree view control or the Windows 3.1 style folder control.

TAR file smart CR/LF conversion - When selected, this option determines if “smart” CR/LF
conversion should be performed when extracting from TAR files. CRI/LF is short for Carriage
Return/Line Feed, the standard end of line indicator. This option can be useful when a TAR file
contains text files created on a Unix or Macintosh machine. Unix text files usually contain lines
ending in Line Feed characters only, and Macintosh text files usually contain lines ending in a
Carriage Return character. The standard Windows Notepad program and many other Windows
programs require a Carriage Return and Line Feed at the end of each line. When the TAR File
smart CR/LF conversion option is in effect, WinZip determines whether to perform CR/LF
conversion for each file inside a TAR file by looking at the first 80 characters in each file. If the
file is a text file then single LF and CR characters are converted to CR/LF pairs so the file can be
viewed by Notepad and other Windows viewers. Files are considered text when the first 80
bytes contain only characters with ASCII values between 0x20 and 0x7f, carriage returns, line
feeds, form feeds, tabs, and other alphanumeric characters (as determined by the Windows
IsCharAlphaNumeric API).

Always have WinZip on top - When checked, WinZip is assigned the “always on top” attribute,
so that it is not overlaid by normal windows.

Beep after long archive operations - WinZip will beep after archive operations that take more
than one second to complete when this option is chosen.

Smart DOC file handling - “Smart DOC Handling” is enabled when selected. This feature is
described in the section titled Double Clicking.

Use Recycle Bin for move operations - When checked, if you select the “move” operation in
the Add or Drop dialog boxes, WinZip will put files in the Recycle Bin instead of deleting them.

Prompt when View button is pushed - Unchecking this option will bypass the View dialog

Related Topics (other Configuration tabs):

View Toolbar Folders System Program Locations




Password Security

WinZip uses the industry standard Zip 2.0 encryption format. Password protecting files in a Zip provides
a measure of protection against casual users who don't have the password and are trying to determine
the contents of your files. The Zip 2.0 encryption format, however, is not as secure as DES and the RSA
public key formats used by programs such as PGP, and does not provide absolute protection against
determined individuals with advanced cryptographic tools.

Note: there are two reasons WinZip does not implement a more secure encryption format: (1) a
different format would not be compatible with the Zip 2.0 standard, so other Zip utilities would not be able
to decrypt the files, and (2) there are currently severe U.S. government restrictions on the export of
encryption technology. If you require strong encryption, we recommend you use a specialized encryption
software instead of the Zip 2.0 encryption format.

The main WinZip window lists password protected files with a plus sign following the filename.
Using password security while using the Extract, Test, CheckOut, or Install features:

If you use the Extract, Test, CheckOut, or Install features on a password protected archive, you will
automatically be prompted for the password.

Using password security while adding or updating an archive:

To password protect files, it is important to specify the password AFTER opening or creating an archive
and BEFORE adding the files.

Follow these steps to password protect files in an archive:

1. Open or create an archive. If you are using the New dialog box uncheck the Add Dialog
checkbox at the right of the dialog box.

2. In the Add or Drop dialog box, click the Password button, and type a password.
Notes:

In addition to the methods specified above, you can select Password from the Options button to specify a
password.

Use the Mask Password checkbox to control whether the password is hidden while typed. If you check
this option, you will have to re-type the password for confirmation (to avoid typographical errors).

Passwords are cleared (reset so that no password is in effect) when an archive is closed or another
archive is opened.

Passwords can also be used for ARJ files; in this case, the external ARJ program is responsible for all
data encryption.

Be sure to remember any passwords you use, so that you can extract your files!



Virus Scanner Configuration

WinZip supports many virus scanners that can be run from Windows or from the DOS command line, with
a few important limitations noted below. Virus scanners can be run using the Scan entry in the Actions
menu or during CheckOut operations if the Run virus scanner option in the CheckOut dialog box is
selected.

Virus scanner configuration is done from the Configuration | Program Locations Dialog Box.

When you first install WinZip, it automatically searches for virus scanners in the folders specified by your
system's PATH and in the “App Paths” Windows registry entries. If one of the supported virus scanners
is found, WinZip will automatically use the scanner. A listing of and further information about currently
supported virus scanners can be found on the WinZip web site at http://www.winzip.com/xvirus.htm

If the installation procedure does not automatically find one of the aforementioned virus scanners, you
can have WinZip automatically fill in the Parameters field by selecting the desired scanner from the drop-
down combo box (for example, scan.exe) and then adding the full filename for the scanner to the
Scanner field (for example, c:\mcafee\scan.exe instead of just scan.exe).

You can also configure WinZip to work with another scanner. See the section titled Virus Scanner
Configuration Details below for more information.

Notes:

The default parameters in the table above work with the versions of the scanners that were tested. If the
authors of a scanner change the command line parameters in future releases of the scanner, then
WinZip's default parameters for the scanner may no longer work. For example, McAfee SCAN 2.1
parameters are incompatible with prior versions of SCAN. Version 2 requires the /ALL parameter while
version 1 requires /A.

Unless a virus is found, no manual intervention is required while running most virus scanners. However,
some virus scanners, such as TFINDVIR, always need to be closed manually, because they do not
currently support options to close automatically.

Virus Scanner Configuration Details

This portion of the documentation describes how to configure WinZip to work with a scanner that is not
listed above. Do not use WinZip's virus scanning support with a different virus scanner unless you have
read and understood the following information.

To configure WinZip to work with a scanner, fill in the following fields in the Configuration | Program
Locations dialog box:

e The Scan program field should contain the name of the program (the full path name is required if
the program is not in a folder specified in your system's PATH).

e The Parameters field should contain the appropriate parameters to run the virus scanner as
described below.

¢ The Run minimized box determines whether the scanner should be run minimized. See below
for important notes on using this parameter with DOS based scanners. Note that some
scanners, such as NAVW32.EXE, always run minimized, regardless how you set this option.
Special character sequences for the Parameters field are:

*x indicates where WinZip should substitute the drive, folder, and the *.* characters for the files
that are to be scanned. For example, “c:\temp\dir\*.*”.

%d indicates where WinZip should substitute the drive and folder of the files that are to be
scanned. Note that the wild card characters *.* are NOT included when you use %d.

Yof indicates where WinZip should substitute the name of a temporary “report file”. Report files
should ONLY be used when running DOS virus scanners.

Y%wscan a special parameter required for McAfee's WSCAN program.

If you do not specify any of the aforementioned special character sequences WinZip will append the



filenames to be scanned at the end of the scanner command line.

Be sure to specify any parameters necessary to cause the scanner to check folders of the drive and folder
of the files that are to be scanned.

To configure WinZip for a Windows-based virus scanner, first ascertain that the virus scanner reports
suspected viruses by displaying a dialog box. If the scanner simply writes to a log file when a virus is
found you (and WinZip) will not know about the problem.

To configure WinZip for a DOS-based virus scanner, be sure to verify that the scanner can either be used
with the Run minimized option (see below for details) or issues a prompt if a virus is found. If neither of
these conditions is met and a virus is found you (and WinZip) will not know about the problem.

The Run minimized check box should only be used for DOS scanners under the following
circumstances:

e The scanner is configured to run in “batch” mode, without any prompts. If the scanner requires
any keyboard input when running minimized, you will not be able to see the prompts, and the
session will appear to be hung.

e The scanner writes all messages through DOS, or has an option to write results to a report file.
Messages written directly to the video buffer are not captured by WinZip and will be lost. To
determine whether a scanner writes messages through DOS, run the scanner with its output
redirected (for example, issue the command “scan > nul"). Any messages you see during this
test will not be captured by WinZip. If the scanner has an option to write results to a report file
you can use %f in the Parameters field to cause WinZip to capture the results (see above for
details).

e The scanner returns a non-zero error level if it encounters any problems. If the scanner does not
return a non-zero error level, WinZip will assume that the files passed the virus check, and any
warnings issued by the scanner will be lost. (Note: if the scanner returns a non-zero error level,
WinZip automatically displays all messages written to standard error or standard output.)



Create Folder

This dialog box lets you create a folder. This folder becomes a sub-folder of the current folder unless you
specify a path.

Note: you can only create folders in existing folders; you cannot create multiple folders at once. For
example, if the following folder is empty

C:\Test Folder

You can create the folder
C:\Test Folder\One Level Is Ok

But cannot create the following two folders at once:
C:\Test Folder\Level One Folder\Level Two Folder



Wizard Interface

(topic entrance macro immediately takes you to wzwizard.hlp file)



WinZip Self-Extractor Personal Edition

Overview

WinZip Self-Extractor Personal Edition is included with WinZip, under the terms of the WinZip License
Agreement. It makes it easy to create files that unzip themselves. The following information applies to
both WinZip Self-Extractor Personal Edition and to WinZip Self-Extractor 2.2, a separately available extra
charge add-on.

What is a Self-Extracting Zip File?

A self-extracting Zip file is an executable program file (.EXE file) that includes a Zip file and software to
extract or “unzip” the contents of the Zip file. Users can run (execute) a self-extracting Zip file just as
they run any other program.

When a self-extracting Zip file created by WinZip Self-Extractor Personal Edition is run, a dialog box is
displayed. This dialog box makes it easy for the user to change the “unzip to” folder before starting the
extract or “unzip” operation.

Self-extracting Zip files created by WinZip Self-Extractor are 100% compatible with the Zip 2.0 file format,
so they can be unzipped by standard unzip utilities like WinZip and PKUNZIP.

What are the advantages to Self-Extracting Zip Files?

Users can extract or “unzip” files from a self-extracting Zip file without running a separate unzip utility or
knowing how to use an unzip utility. Thus, self-extracting Zip files are particularly suited distribution of
software to beginning users who are not familiar with the concept of Zip files.

Self-extracting Zip files created by WinZip Self-Extractor are native Windows programs so they are easy
to use even for users with no MS-DOS experience.

How Does it Work?
There are two parts to the process:
e The WinZip Self-Extractor program creates self-extracting Zip files.

¢ When WinZip Self-Extractor creates a self-extracting Zip file it includes part of itself in the self-
extracting Zip file. The part of WinZip Self-Extractor included in the self-extracting Zip file is what
makes it possible to unzip the files by simply running the self-extracting Zip file.

The person who creates the self-extracting Zip file runs WinZip Self-Extractor once, specifying the name
of the Zip file. The resulting self-extracting Zip file can be distributed to many people, and will unzip itself
when it is run.

Related Topics:

WinZip Self-Extractor Personal Edition - Operation
WinZip Self-Extractor 2.2



WinZip Self-Extractor Personal Edition - Operation

The easiest way to start WinZip Self-Extractor Personal Edition is to first create a normal Zip file with
WinZip, then select Make .Exe File from the WinZip Actions pull-down menu. This will activate WinZip
Self-Extractor Personal Edition unless you have specified a different program in the Make Exe field in the

Configuration | Program Locations Dialog Box. If you chose to create a WinZip Self-Extractor Personal
Edition icon while installing WinZip, you can also start the program by double clicking on this icon.

WinZip Self-Extractor Personal Edition dialog box contains the following fields:
Create Self-Extracting Zip file from:

The name of the standard (not self-extracting) Zip file to turn into a self-extracting Zip file.
Default “Unzip To” folder:

The default target folder for the unzip operation. If left blank the folder specified by the user's
TEMP= environment variable is used.

Self-Extracting Type

16-bit Windows 3.1 - This option creates self-extracting Zip files that run under Windows 3.1,
Windows 95/98, and Windows NT. However, if the Zip file contains files with long filenames and
if the self-extracting Zip is run on Windows NT, a message box is displayed warning the user of
potential problems, and any long filenames will be truncated.

32-bit Windows 95, 98 and NT - This option creates self-extracting Zip files that include full
long filename support under Windows 95/98 and Windows NT. Because these self-extracting
files are full 32-bit programs they will not run under Windows 3.1 or Windows for Workgroups.

Spanning Support

Removable disks such as diskettes have very limited storage capacity. Sometimes, self-extracting
Zip files you create will not fit onto a single diskette. In this case, you can ask WinZip Self-
Extractor to save one Zip file across multiple diskettes. This process of creating a Zip file that
occupies multiple disks is called “spanning”.

When you span Zip files across multiple disks using WinZip Self-Extractor, no special software is
required during extraction. Your users are simply prompted to insert any additional disks in the
multiple volume set at the appropriate time during extraction.

The following choices determine whether you want to make use of the spanning feature to create
a single Self-Extractor on more than one removable disk, and which method to use.

¢ No Spanning - WinZip will not create a .exe that spans removable disks.

e Safe spanning method - Selecting the Safe method causes WinZip Self-Extractor to put
two files onto the first disk: a .ZIP file with the first portion of your compressed data, and a
small .EXE file with the executable code that is required to extract your data. The second
and subsequent disks contain .ZIP files with the remaining portions of your compressed
data. The Safe method is the default, and recommended, method.

¢ Old spanning method - In contrast, the Old spanning method puts a .EXE file on the first
disk that contains both the executable code used to extract the compressed data and the
first portion of that data. The second and subsequent disks contain the remaining portions
of your compressed data, in files that (even though they don't actually contain any
executable code) have an extension of EXE. This is potentially dangerous because, if a
user inadvertently tries to run the EXE file on the second or succeeding disks, random
error messages, and even system hangs, can occur.

Note: The WinZip Self-Extractor cannot make use of unformatted disks. All of the disks that you
use with WinZip Self Extractor must already be formatted.

Other Options:
Use CTL3D.DLL for 3D effects if available - CTL3D.DLL is used by many applications to



generate 3D effects so there is a good chance it will exist on a lot of target systems. If this option
is specified WinZip will try to load CTL3DV2.DLL, and if not found, will try to load CTL3D.DLL.
Note that there is no way for WinZip Self-Extractor to guarantee that the CTL3D*.DLL on the
target system will function properly. This option is not available when creating 32-bit self-
extracting files.

Overwrite by default - This check box determines if the “Overwrite files without prompting”
option in the self-extracting Zip file's dialog box should be checked by default.

Click OK to create the self-extracting Zip file. Be sure to test the Zip file before distributing it.
Related Topics:

WinZip Self-Extractor Personal Edition - Overview
WinZip Self-Extractor 2.2



WinZip Self-Extractor 2.2

WinZip Self-Extractor Personal Edition is included with WinZip, under the terms of the WinZip License
Agreement. WinZip Self-Extractor 2.2, a $49 add-on to WinZip, includes the following features not
available in the Personal Edition:

Features to automate and customize software installation, such as the ability to specify an icon
and text for the main self-extractor dialog box, and to delete temporary files after running a setup
program. It includes support for the InstallShield 3.0 SETUP program.

Ability to run a command when the unzip operation completes.

Self-Extracting files can be created from the command line.

An option to create a single self-extracting Zip file that runs under either MS-DOS or Windows.
All versions can be created with English or German messages.

Ability to automatically extract files when the EXE file is run.

A Wizard to simplify the process of building self-extracting files.

Click here for information on obtaining WinZip Self-Extractor 2.2.

Related Topics:

WinZip Self-Extractor Personal Edition - Overview
WinZip Self-Extractor Personal Edition - Operation



Obtaining WinZip Self-Extractor 2.2

Note: at the time of this writing, WinZip Self-Extractor 2.2 has not been released. If you order
WinZip Self-Extractor 2.2 before it is released, you will receive WinZip Self-Extractor 2.1, and will
be able to download a free upgrade to WinZip Self-Extractor 2.2 when it is released.

WinZip Self-Extractor 2.2 costs $49 for a license to create an unlimited number of re-distributable self-
extracting Zip files on a single machine. Click here for information on the differences between WinZip
Self-Extractor 2.2 and the Personal Edition included with WinZip.

You can order WinZip Self-Extractor 2.2 by credit card via the WinZip home page (http://www.winzip.com)
or by phone, fax, or e-mail as described below. You can also order using CompuServe's SWREG
service by registering product ID 4866, or by sending a check for $49 to Nico Mak Computing, Inc. at P.O.
Box 540, Mansfield, CT 06268, USA. All payments must be in US funds drawn on a US bank. Shipping
by postal mail is included in the $49 price. Be sure to include your name, your organization name, and, if
you are ordering by credit card, your credit card number, expiration date, and the name as it appears on
the card.

Credit card orders for WinZip Self-Extractor 2.2 can be placed through PsL, a credit card ordering service.
The best way to reach PsL is by fax to 1-713-523-9803 or by e-mail to 10273@pslweb.com. You can also
call PsL at 1-877-724-4600 (toll free in the U.S.) or 1-713-610-1432 between the hours of 8:30 am and
5:00 pm CST Monday-Friday, except holidays. You can send credit card orders via postal mail to PsL at
P.O. Box 35705, Houston, TX 77235 USA. Please be sure to include a completed WinZip Self-Extractor
order form and a completed credit card information form with your order. Important: these numbers are for
credit card orders only. All other inquiries should be directed to Nico Mak Computing, Inc.

You can download a fully functional evaluation version of WinZip Self-Extractor 2.2 from the WinZip

Self-Extractor web page at (http://www.winzip.com/winzipse.htm).



Double Clicking

Double clicking on a filename listed in the main WinZip window will perform the same action performed
when you double click on a file in My Computer or the Windows Explorer. If the file is executable (has a
filename extension of EXE, COM, BAT, or PIF), WinZip will run it. Otherwise WinZip will open the file
with the appropriate application. For example, files with a filename extension of .TXT are opened by the
Windows Notepad application (unless you have changed the TXT association). The appropriate
application is determined via Windows Associations. If no application is associated with the file, WinZip

will run the program specified as the Default association in the Configuration | Program Locations Dialog
Box. If you modify the file while viewing it, WinZip will offer to add the modified file to the archive.

If the Smart DOC handling option in the Configuration | Miscellaneous Dialog Box is enabled and you
doubile click on a file with a file type of .DOC, WinZip will run one of two programs:

e If the .DOC file looks like plain ASCII text WinZip will run the program specified as the Default
association in the Configuration | Program locations dialog box.

e |fthe .DOC file looks like a file created by a word processor WinZip will run the program
associated with .DOC files.

Smart Doc Handling avoids the overhead of loading a word processor like Word for Windows when
viewing ASCII text files like “readme.doc”.

Note: Pressing the Enter key performs the same action as double clicking.



File Properties

The File Properties dialog box is displayed when you select Properties from the right-click context menu
for files listed in the main WinZip window. This dialog box lists the following information: Name, Type,
File size, Packed Size, Ratio, Modified, Path, and CRC. This feature is particularly helpful when you have
elected not to display some of these values in the Configuration | View dialog box.




Windows Associations

Microsoft has defined the word “associate” as follows:

To identify a filename extension as belonging to a certain application, so that when you open any file with
that extension, the correct application is opened automatically.

For example, by default, Windows associates .WRI files with the Write or WordPad application, and .TXT
files with the NOTEPAD application. Most Windows application installation procedures create
associations. For example, Word for Windows creates an association for .DOC files, while WinZip
creates associations for files with the extensions ZIP, LZH, ARJ, ARC, CAB, TAR, TGZ, TAZ, GZ, Z, UU,
UUE, XXE, B64, HQX, BHX, MIM.

WinZip uses associations when you Double Click on a filename listed in the main WinZip window and
when you use the CheckOut Feature.

WinZip, My Computer, the Windows Explorer, and the File Manager all use associations the same way.
When you double click on a file with an association, the application associated with the file is run, and the
application automatically opens the file. The WinZip CheckOut facility establishes associations when it
updates the CheckOut program group for two reasons: to display the right icon for each file, and to ensure
that the appropriate application is run when you double click on an icon.

You can view, add, and remove associations using the File Types tab in the Options dialog box in My
Computer or Explorer. Select Options from the View pull-down menu in My Computer or Explorer, then
click the File Types tab. Press the F1 key for detailed instructions.



Multiple Disk Spanning
WinZip makes it easy to create Zip files that “span” multiple disks. This is useful if the files you are
working with will not fit on one disk.

To make a Zip file that spans multiple disks, simply create a Zip file on a removable disk, then add files to
the Zip as you normally would. If the disk fills during Add operation, you will be prompted for another
disk. Simply insert the next disk and click the OK button.

Important: disk spanning is not available when adding files to an existing archive; it is only available
while creating a new archive. Also note that you cannot add or remove files from a Zip file that spans
disks. WinZip requires pre-formatted disks (you can format disks using My Computer or the Windows
Explorer).

Example:
To zip the files in your c:\data folder to a Zip file called A:\DATA.ZIP:
1. Start WinZip.

2. Drag and drop the c:\data folder from My Computer or the Windows Explorer to the WinZip
window.

3. In the Drop dialog box, type the filename of the Zip file (A:\\DATA.ZIP).
4. Click the Add button.

If more than one disk is needed, you will be prompted for additional disks.



Norton Navigator for Windows 95

Restoring the association for Zip files after installing Norton Navigator:

Norton Navigator SETUP associates Zip files with Norton Navigator. If you subsequently run WinZip it
will offer to re-associate itself with Zip files. If you choose “Yes” you can use WinZip exactly as you did
before installing Norton Navigator. Note: it is possible the icons for Zip files will not change until you re-
boot Windows 95/98/NT.

Using WinZip with Norton File Manager:

You can start WinZip by double clicking on Zip files in Norton File Manager after following these steps:
(1) select General from the Norton File Manager Options menu, (2) in the Advanced tab uncheck the
“Show compression files as Directories” checkbox, and (3) press OK.

Restrictions:

The Norton File Manager does not support Explorer shell extensions, so you cannot use the WinZip shell
extension to drag a Zip to a folder to unzip it. However, you can still do this after installing Norton
Navigator by running the Windows 95/98/NT Explorer or by double clicking on My Computer.



Keyboard Usage

WinZip is easier to use with a mouse, but you can also use the standard Windows keyboard interface.
Keyboard accelerators defined for WinZip include:

F1 Activate help system

Ctrl+N Create a new archive.

Ctrl+O Open an existing archive.

Shift+F Favorite Folders.

Shift+L Close an archive.

F7 Move an archive

F8 Copy an archive

Shift+R Rename an archive.

Shift+M Mail an archive.

Shift+A Add files to an archive.

Shift+D Delete files from an archive.
Shift+E Extract files from an archive.
Shift+V View files in an archive.

Ctrl+P Print a listing of files in an archive.
Shift+W Switch to the Wizard interface.
Ctrl+A Select all items in the list box.
Shift+S Run virus scanner.

Shift+T Test an archive.

Shift+U Uuencode an archive.

Shift+G View, add, or edit a comment
Shift+K Create a self-extracting archive.
Shift+C Activate the CheckOut feature.
Shift+l Install files in an archive.

Direction key(s) Move the cursor and/or scroll a list.
Shift+direction keys Select multiple items in a list box.
Enter Same as Double Clicking in the main window.
Alt+F4 Exit (terminate) WinZip

What’s New in WinZip 7.0

New features in WinZip 7.0 include:

Support for Microsoft’s CAB (cabinet) format, including most self-extracting CAB files.

Sizable, sortable, and selectable columns in the main window. The optional attribute and CRC
columns are new. Columns can be resized with the mouse, and turned off from the
Configuration | View dialog box. Just click on a column header to sort.

A configurable toolbar with 21 toolbar buttons. (Note: some toolbar configuration options require
version 4.71 or later of the Windows Common Control library. This library is part of Windows 98,
Microsoft Internet Explorer 4.0, and is available as a separate download from Microsoft, as
described in the section titled Windows Common Control Library.

Optional support for the Internet Explorer 4.0-style “one click open” interface. If this option is
enabled in Internet Explorer 4.0 Active Desktop, it will be enabled in WinZip automatically.
Otherwise, you can turn it on using the Configuration | View dialog box.



A print facility to print the information listed in the main WinZip window.
Improved configuration using a tabbed dialog box.

Zip comment support.

Improvements to the Install Feature.

Optional Tip of the Day dialog box.

WinZip Self-Extractor Personal Edition (included with WinZip) now creates Zip files that span
multiple removable disks.

A list of features introduced in earlier versions of WinZip is available from the WinZip web site at
http://www.winzip.com/version.htm.



Hints and Tips

Here are the hints and tips displayed by the “Tip of the Day” dialog box:

The Tip of the Day dialog box is normally displayed when you start WinZip but are not
automatically opening a Zip file. You can change this option so tips are never displayed, or
always displayed when WinZip is started.

If you turn the Tip of the Day off and later want to restore it, select Tip of the Day from the WinZip
Help pull-down menu, then select from the combo box at the bottom of the dialog box.

If you are new to Zip files, you can use the Wizard interface to walk you through the process of
unzipping or installing software in Zip files. Select Wizard from the WinZip File menu to activate
the Wizard.

You can add, remove, or reorder buttons on the WinZip toolbar by right clicking on the toolbar and
choosing Select Buttons.

WinZip's toolbar buttons look much better if your display is in high-color mode.

Click “Control Panel” in the Start menu's Settings entry. Double-click “Display” and select the
Settings tab. Choose “High Color” mode for Color Palette (under Windows NT 4.0 select
65536).

You can use Quick View, the optional Windows file viewing utility, to view files without
associations. If Quick View is not installed, see the section titled Installing QuickView. To use
Quick View with WinZip, select Configuration from WinZip's Options menu, click the Program
Locations tab, type “quikview” (without the quotes) in the Default association field, and click
OK.

Learn to use the Windows help system! All Windows programs use the same help system, so
you will quickly make up for the time you spend learning it by being more productive in all your
Windows applications. To get started select How to Use Help from the Help menu.

For a Brief Tutorial on WinZip, select Brief Tutorial from the WinZip Help pull-down menu.

For quick zipping and unzipping, you can right-click on a file listed in Explorer and choose Add to
Zip or Extract To from Explorer's context menu.

For answers to EFrequently Asked Questions (FAQs), select Frequently Asked Questions from
the WinZip Help pull-down menu.

You can unzip all files from a Zip without leaving the Explorer. Use the right mouse button to
drag and drop a Zip file from an Explorer window to any folder, then choose Extract To from the
context menu. Be sure to use the right mouse button while dragging.

You can create Zip files in the Explorer: right click in the Contents pane, then select New and
WinZip File. An empty Zip file will be created in the current folder.

Mailing your Zip files is easy! If you are using a MAPI-compatible mail system, you can mail Zip
files using the Mail Archive entry in the WinZip File menu. Or, click the WinZip status line, drag it,
and drop it on your e-mail program.

If you usually use the same folders when opening, extracting, or adding files, specify those
folders in the Configuration | Folders dialog box.

You can run your virus scanner on the files inside downloaded Zip files. Choose Virus Scan from
WinZip's Actions menu.

If you need to send files to users who may not have an unzip utility, try “WinZip Self-Extractor
Personal Edition” (included with WinZip). The self-extractor makes files that unzip themselves.
First create a zip file, then select Make .Exe File from the WinZip Actions menu.

To change the default WinZip window size and position to the current window size and position,



choose Save Settings Now from the Options menu.

¢ To display details about the open Zip file (for example, the date the Zip file was last modified or
the name of the folder containing the Zip file), click on the WinZip status line or select Properties
from the WinZip File menu.

*  You can make a Zip file that spans multiple disks. Simply create a Zip file on a removable disk,
then add files to the Zip as you normally would. If the disk fills up while files are being added,
you will be prompted for another disk. Just insert the next disk and click the OK button.

e The file listing for an archive can be quickly sorted by any of the fields displayed in the file listing.
Just click on any column title to sort on it.

¢ You can interrupt an archive operation by clicking anywhere in the WinZip window. This will
activate the “Operation Interrupted” dialog box.

¢ You can quickly extract files from a Zip file by dragging the files from WinZip to any folder or
Explorer window (or even to the desktop).

¢ You can quickly add files to a Zip file by dragging the files from any folder or Explorer window to
WinZip.
e WinZip has many features that make it easy to work with files downloaded from Internet, bulletin

boards, and online services like America Online and CompuServe. For a list of hints, see the
section Hints For Working With Downloaded Files

e Besides Zip files, WinZip processes many other formats, including TAR, Z, GZ, TGZ, CAB,
UUencode, BinHex, and MIME.

¢ If you can't remember where you put your Zip files, you can use the Favorite Zip Folders feature
to find them. Select Favorite Zip Folders from the WinZip File menu.

* You can easily view files in a Zip file by dragging them to an application or a shortcut to an
application.

¢ You can easily print files by dragging them to a printer or shortcut to a printer. (To print a list of
files in a Zip, select Print from the File menu.)

e Zip files opened with WinZip are added to the Start menu's Documents list. To quickly open Zips
that you have recently worked with, select Documents from the Start menu.

¢ You can add selected files to a Zip directly from the Explorer with complete control over the
options. RIGHT-click on any file (or selected group of files) and choose Add To Zip from the
context menu.

¢ Answers to frequently asked questions are available by selecting Frequently Asked Questions
from WinZip’s Help menu.

Related Topics:

More Hints and Tips
Hints For Working With Downloaded Files

Windows 95/98 and NT 4.0 Quick Examples

Frequently Asked Questions (FAQs




More Hints and Tips

Here are more Hints and Tips:

e To switch to another program during an archive operation, click on the window for the other
program, or hold down the Alt key and press the Tab key repeatedly until the program's icon is
selected. Note: you cannot use the WinZip system menu or minimize button during archive
operations.

*  You can move or copy files from one archive to another by opening multiple WinZip windows, one
for each archive, and dragging files from one to the other. Note that you need to turn off the
Reuse WinZip Windows entry in the Options pull-down menu in order to start multiple WinZip
windows.

e WinZip can now be used to compress files with cc:Mail. To use this feature change the
compress= line in the [cc:Mail] section of the appropriate WMAIL.INI files to specify the full path
for WinZip followed by “-a %1 @%2”. For example, if WinZip is installed in your c:\winzip folder,
specify

compress=c:\winzip\winzip.exe -a %1 @%2

Long Filename Tips
e The current versions of most optional external archivers used by WinZip are DOS programs and
do not support long filenames. Therefore, WinZip will pass the short 8.3 version of all long file
and folder names to these external programs. Since normal 8.3 names are usually more
meaningful than the shortened versions of long filenames, it is recommended you use standard
8.3 filenames when working with external archivers.

e The exception is ARJ 2.60, which does support long filenames when running under Windows
95/98 only (not under Windows NT). If WinZip detects that you are using ARJ 2.60 or later and
you are using Windows 95/98, it will pass long filenames to ARJ.

e MS-DOS (other than ARJ 2.60) and 16-bit Windows programs usually have trouble with long
filenames and files with spaces in the name. Therefore, it is recommended that you do not use
long filenames and files with spaces in the name if you plan to work with these files from DOS.
For example, LHA.EXE will extract the file “A Long Filename” as “ALONG F", ignoring the extra
characters. To avoid this problem check the Store filenames in 8.3 format checkbox in the
Drop dialog box when adding files.

Related Topics:

Hints and Tips
Hints For Working With Downloaded Files

Windows 95/98 and NT 4.0 Quick Examples

Frequently Asked Questions (FAQs




Hints for Working With Downloaded Files

WinZip makes it easy to work with files downloaded from Internet, bulletin boards, and online services like
America Online and CompuServe.

e The WinZip Internet Browser Support Add-On adds features to work hand in hand with Netscape
Navigator/Communicator or Microsoft Internet Explorer.

e The Install feature makes it easy to install most software distributed in Zip files: if a Zip file
contains a “setup” or “install” program, WinZip will unzip the files, run the installation program,
and clean up temporary files. If the Zip file does not contain a setup program, you can use the
CheckOut Feature to try the downloaded file.

e The Favorite Folders feature makes locating Zip files you want to open much easier.

e The Downloading and Processing Files with WinZip topic provides further hints, tips, and helpful
procedures.

e The Archive Management features make it easy to move archives to floppies, or to delete them if
they don't meet your needs.

To print this page, click on Print Topic in the Help window's File pull-down menu.
One strategy for handling downloaded files involves three folders:

\DOWNLOAD Recently downloaded files
\UPLOAD Files you are planning to upload
\ARCHIVES Archives you are planning to keep

A relatively empty download folder makes it much easier to stay organized. Itis a good idea to download
all archives into your \DOWNLOAD folder, and after each on-line session perform the following steps for
each archive:

1. Open the archive. An easy way to open files is to first open the \DOWNLOAD folder in My
Computer or the Windows Explorer. Then double click on an archive to openit. You will
probably want to select Sort by date from the File Manager's View pull-down menu or click on
the Modified column header in My Computer or the Windows Explorer so that the most recent
files are shown at the top of the list.

2. Read about the software in the archive. Many archives contain a file named “file_id.diz”. By
convention this file contains a brief description of the archive contents. If this file is listed in the
main WinZip window, double click on it to view its contents. When you are done viewing the file,
close the program being used to view the file. Repeat this process for any files with the word
“read” in the filename (e.g. “readme.txt” or “read.me").

3. Try the software if the archive looks interesting. One easy way to do this is with the Install or
CheckOut buttons on WinZip's toolbar. If the archive contains an “install” or “setup” program,
the Install button will be displayed, otherwise, it will contain the CheckOut button. Note:
downloaded software should always be scanned for viruses before you install or use it. If
you download archives containing software, you should obtain a reliable virus scanner, keep it up
to date, and always use it on the contents of such downloaded archives. See the section titled
Virus Scanner Configuration for information on configuring WinZip to use your virus scanner to
test the contents of archives for virus infection.

4. Move each archive out of your download folder after trying the software. If you want to keep the
archive on your hard disk select Move from the File menu to move the archive into your \
ARCHIVES folder, or, if you want to post the archive on another BBS, move it into your \UPLOAD
folder. Note that the folders you have most recently used for move and copy operations are
available for quick access in a drop-down list. If you don't want to keep the file you downloaded
you can easily move it to a floppy or delete it using the Delete entry in the File pull-down menu.

Of course, these are just suggestions. There are other good ways to use WinZip to work with downloaded



files. Feel free to use whatever method works best for you.

Related Topics:
Hints and Tips
More Hints and Tips

Windows 95/98/NT Shell Integration Examples
Frequently Asked Questions (FAQs



Windows 95/98/NT Shell Integration Examples

Here are some quick examples of the smooth integration of WinZip into Windows 95/98/NT:
Zip and Unzip Files Without Leaving the Explorer:

¢ To extract all files in a Zip without leaving Explorer: use the right mouse button to drag and
drop a Zip file from an Explorer window to any folder, then choose “Extract to” from the context
menu. Be sure to use the right mouse button while dragging.

¢ To add files to a Zip without leaving Explorer: just select one or more files in Explorer and
drag and drop them on a Zip file in the active Explorer window, in another Explorer window, or to
a Zip file on the desktop. Note that you can create Zip files in Explorer by selecting New-
>WinZip File if you right-click in Explorer.

e Another way to add files to a Zip directly from Explorer: right-click on any file (or selected
group of files) in Explorer and choose “Add To Zip” from the context menu.

Using the Desktop:

e If you select Add WinZip To Desktop in WinZip's Configuration | System Dialog Box, you can
drag one or more files to the WinZip icon on the desktop to add the files to an archive of your
choice.

e To create a Zip file on the desktop, right-click anywhere on the desktop and select WinZip File
from the New submenu.

Using drag and drop from the main WinZip window:
¢ To extract a file: drag a file to a folder listed in any Explorer window.
¢ To view a file: drag a file to the appropriate application window or to a shortcut to the application.
e To print a file: drag a file to a printer or a printer shortcut.

Using the Start Menu:

e |f you select Add WinZip to Start Menu in WinZip's Configuration | System Dialog Box, you can
start WinZip directly from the system Start Menu.

e You can open a recently accessed archive from the Documents submenu in the system Start
Menu.

Related Topics:

Hints and Tips

More Hints and Tips
Hints For Working With Downloaded Files

Frequently Asked Questions (FAQs




Frequently Asked Questions

For the most up-to-date Frequently Asked Questions, click the FAQ link on the WinZip Home Page
(http://www.winzip.com).

Basic

How do | get started?
Technical
How do | use disk spanning?

How do | compress a folder and later restore it?

How do | view graphic/spreadsheet/word processing files in an archive?
Non-Technical

How do | purchase WinZip?

Do you keep track of address changes?

Related Topics:

Hints and Tips

More Hints and Tips

Hints For Working With Downloaded Files
Windows 95/98/NT Shell Integration Examples



Fixing Zip Files

If a ZIP file is damaged it can sometimes be repaired with the PKZIPFIX command. PKZIPFIX is not part
of WinZip, it is part of the MS-DOS text mode Zip utility PKZIP® 2.04g from PKWARE®), Inc. This utility is
available on many ftp and download sites as PK204G.EXE. If you download and install this file, you can
run PKZIPFIX by simply typing

PKZIPFIX filename
at the DOS prompt, and PKZIPFIX will create the “fixed” file PKFIXED.ZIP.



Message WZ11

A required file was not found.
The file listed in the dialog box was not found in your path or the specified location. Also, WINZIP.HLP,
WZ.DLL, WZ.COM, and WZ.PIF must both be in the same folder as WINZIP.EXE. The Installation

section describes the complete installation procedure.



Message WZ13

This dialog box is displayed if a filename is invalid or if WinZip was unable to open the specified archive
or read the archive folder. It is possible that the file is not an archive or does not exist. Alternately, it is
possible that the archive has been corrupted. Other reasons for this error include insufficient memory
and disk errors while reading the archive.

If you are working with a Zip file, you can try repairing the file as described in the section Eixing Zip Files.



Register WinZip
If you paid the WinZip registration fee:

If you paid the WinZip registration fee and received a registration number from Nico Mak Computing or an
authorized reseller, please enter your name and registration number exactly as they appeared on the
instructions you received when you registered WinZip. You cannot substitute a different spelling for
your name or use a different name. If entered correctly, your name will appear in the About dialog box,
and the registration reminder dialog box will no longer be displayed when you start WinZip. Please save
this information for possible use with future upgrades, or in case you re-install WinZip.

Note: if your name is spelled incorrectly in the instructions, please write to the address in the About dialog
box with the correct spelling, and you will receive a new registration number.

If you have not yet paid the WinZip registration fee:

If you downloaded an evaluation version of WinZip, or if you received this version of WinZip on a disk or
CD with a book or with other hardware or software, and you have not paid the WinZip registration fee, you
are licensed to use WinZip for evaluation purposes only, subject to the Evaluation License.

For information on purchasing a license to use WinZip for non-evaluation purposes, see the section
Ordering Information.



Internal Error

This dialog box is displayed when an unexpected WinZip internal error occurs. Please contact Nico Mak
Computing with as much information about the error as possible. For a list of contact points, choose

About from WinZip's Help pull-down menu.



Message WZ14

This dialog box is displayed when a required edit field is empty or no entries are selected in a list box.
For example, it is displayed if you don't specify which file you want to open in the Open Archive dialog
box. Specify the required information and try again.



File already exists

To view a file, WinZip normally extracts the file to disk, reads it, and erases the temporary disk file.
WinZip determines which disk to extract to by checking the value of the WZTMP=, TMP=, TEMP=, and
PKTMP= environment variables. To conserve space on the DOS command line, WinZip creates
temporary files in the root folder of the specified drive. If none of these environment variables is set,
WinZip extracts to the root folder of your C: drive.

The message The disk file “filename” already exists. Should WinZip overwrite it so that the file in the
Zip can be viewed? is issued if a file with the requested name already exists on disk. If you choose Yes,
the existing disk file will be overwritten, and processing will continue. If you select No, WinZip will cancel
the view operation for this file.



Warning WZ16

This dialog box is displayed if WinZip cannot display the entire file you are viewing because it contains
binary zeros. WinZip uses a standard multi-line edit field to display files, and these controls truncate text
at the first binary zero.



Message WZ8

This dialog box is displayed if an external command (for example, LHA or ARJ) is over 127 characters
long (the longest command allowed under MS-DOS is 127 characters). The total command line length
includes several components used internally by WinZip in addition to the external command. There are a
few ways to reduce the length of the command line:

¢ Move WINZIP.EXE (and the related files) to a folder near the root folder (for example, a folder like
C:\WINZIP is better than C:\WINDOWS\UTILITY\SHAREWAR\WINZIP).

¢ Move the archive you are working with to a folder near the root folder.

¢ Move ARJ.EXE, LHA.EXE, SCAN.EXE, etc. to a folder specified by your PATH= environment
variable and remove any folder names for these programs in the Configuration | Program
Locations dialog box.

e If you are adding, deleting, extracting, or viewing multiple files at one time, specify them via a list
box rather than an edit field. This causes WinZip to create an ARJ or LHA response file, which
usually takes less room on the command line than multiple file names.



Text Successfully Copied To Clipboard

This dialog box is displayed to let you know the text in the View dialog box has been copied to the system
clipboard. You can paste the text into another application (for example, Notepad) by choosing Paste
from the application's Edit pull-down menu.



Message WZ18

This dialog box is displayed when WinZip could not create a required temporary file on the disk drive
listed in the dialog box. Possible causes are that the disk drive is invalid, or that the root folder of the
disk is full.

WinZip determines which disk to use for temporary files by checking the values of the WZTMP=, TMP=,
TEMP=, and PKTMP= environment variables. To conserve space on the DOS command line, WinZip
creates temporary files in the root folder of the specified drive. If none of these environment variables is
set, WinZip creates temporary files on your C: drive.



Message WZ19

When working with format files the “action” operation requires the program external program. This
program is not installed or improperly installed.

This message is issued when the external program “program” required for the “action” operation is either
not installed, or is installed in a folder other than the one specified in the Configuration | Program
Locations dialog box. If the specified program is installed, select Configuration from the WinZip Options
pull-down menu, click the Program Locations tab, and specify the correct path information. If you do not
have a copy of the specified program, see the section titled Requirements for information on obtaining the

program.



Message WZ20

The program required to perform the function you selected is either not installed, or is installed in a folder
other than the one specified in the Configuration | Program Locations dialog box. For a complete list of
supported external programs and information on obtaining these programs see the section titled System

Requirements. Also see the section titled Installing Optional External Programs.
For example, this problem can occur if you try to extract files from an ARC file, but have not specified an

ARC extraction program in the Configuration | Program Locations dialog box.



Message WZ21

WinZip can't find one of the programs specified in the active dialog box. If you specified a folder (for
example, you entered C:\UTILITY\LHA.EXE), then WinZip can't find the program in that folder. If you did
not specify a folder (for example, you entered LHA.EXE) then WinZip can't find the program in any of the
folders specified by your PATH= environment variable.

Note: if you update the PATH statement in your AUTOEXEC.BAT, the changes will not take effect until you
reboot your machine.



Message WZ22

WinZip does not recognize the name of the specified program. For example, you will get this error if you
specify XYZ.EXE as the name for LHA.EXE. WinZip lets you specify the drive and folder containing the
program, but prevents the use of unsupported file names to prevent unexpected errors.



Message WZ23

An external program returned a non-zero error level. Consult the documentation for the external
program for the meaning of the error, and/or use the View Last Output entry in the Options pull-down
menu to check for error messages issued by the external program.

Note:

One likely cause for this error is using an old version of external programs. See the section titled System
Requirements for version information.



Delete Entire Archive

This dialog box is displayed to give you a chance to confirm that you really want to delete the entire
archive. Select No to abort the operation or Yes to delete the archive.



CheckOut Delete

This dialog box is displayed before closing an archive to give you a chance to have WinZip delete the
CheckOut folder and the CheckOut program group. Select Yes to delete these items and close the
archive. Select No to leave the CheckOut group and folder intact and close the archive. Select Cancel

to cancel the close operation.



Message WZ24

WinZip does not provide facilities to create files in the CAB, Microsoft compress, ARC, BinHex, MIME,
TAR, gzip, or z formats; however, you can open an existing archive in these formats and extract, run, or
view the files inside these types of archives. You can create Uuencoded files using the Actions-

>Uuencode menu entry.



Message WZ25

This dialog box is displayed when WinZip cannot run a program. This can happen when a program
specified as a Windows Association was deleted from your system or was moved to a different drive or
folder. The following are the error codes Microsoft has documented:

0 Out of memory

1 File not found

2 File not found

3 Path not found

4 Too many files open

5 Attempt to dynamically link to a task

6 Library requires separate data segments for each task

8 Insufficient memory to start application

10 Incorrect Windows version

11 Invalid .EXE file (non-Windows .EXE or error in .EXE image)

12 OS/2 application

13 DOS 4.0 application

14 Unknown .EXE type

15 Attempt in protected (Standard or 386 Enhanced) mode to load an .EXE created for
an earlier version of Windows

16 Attempt to load a second instance of an .EXE containing multiple, writeable data
segments

19 Attempt was made to load a compressed executable file. The file must be
decompressed before it can be loaded.

20 Dynamic-link library (DLL) file was invalid. One of the DLLs required to run this
application was corrupt.

21 Application requires Microsoft Windows 32-bit extensions.

Message WZ26

WinZip encountered an error trying to view a file. Possible errors include insufficient memory and disk
errors.



Message WZ27

An incomplete filename was entered. If either a drive or folder is specified, then both must be specified.
For example, the following two filenames are incomplete:

C:LHA.EXE
\UTILITY\ALHA.EXE

In the first example, a drive is specified but no folder is specified. This can cause unexpected errors if
you change the current folder on the C: drive.

In the second example, a folder is specified but no drive is specified. This can cause unexpected errors
if you change the current drive.

Specify a filename like C:\UTILITY\LHA.EXE instead. Note that if the file is in a folder specified by your
PATH= environment variable you do NOT need to enter a drive and folder.



Warning WZ28

You used the Drag and Drop Interface to drop multiple files onto a WinZip window or icon, and at least
one of these files had an extension of ZIP, LZH, ARJ, or ARC. Press Yes to add these files to the open
archive.



Message WZ30

WinZip could not change to the specified folder, so it is closing the open archive. Possible causes for
this error include removing the folder or changing disks in the middle of a WinZip operation.



Message WZ31

An unexpected system error was encountered trying to run the specified DOS command. This problem
is usually caused by a system configuration problem such as using a Windows 3.0 video driver on a
Windows 3.1 system, or using buggy video drivers, including “beta test” video drivers.

If you encounter this error message and are not using a Microsoft supplied video driver, try installing the
VGA driver distributed with Windows to determine if the problem is caused by a video driver.



Overwrite?

The specified file already exists on disk. Choose Yes to overwrite the file or Yes to All to overwrite this
file and avoid this prompt for all other files during this operation. Choose No to bypass this file and
continue the operation or Cancel to abort the extract operation.



File has been changed

WinZip detected that you modified a file while viewing it. Choose Yes to add the modified file to the
archive or No if you don't want to update the archive.



Warning WZ35

The original file included folder information, but no folder information was included when the file was
added to the archive. Thus, both the original and the new file are included in the archive.



Delete Temporary File?

Choose Yes to delete the temporary file or No if you want to keep it. Note that the file resides in a
“temporary” folder specified by your WZTMP=, TMP=, TEMP=, and PKTMP= environment variables, so
you should probably move the file to a “permanent” folder if you really want to keep it.



Message WZ38

WinZip cannot accept dropped files while the Drop dialog box is active. Close the Drop dialog box before
dropping more files on WinZip.



Message WZ39

WinZip requires ARJ 2.5 or later. Please obtain a newer version of ARJ. See the section titled System
Requirements for information on obtaining the most recent version of ARJ.



Message WZ40

The Zip file cannot be opened. If this Zip file is part of a backup set, please insert the last disk of the
backup set and try again (this is required by the standard Zip multi-disk format). You may subsequently
be prompted to insert other disks from the backup set.

If you downloaded this file, the most likely cause of this problem is a bad download. The best solution is
almost always to download the file again. If this does not solve the problem, see the web page
http://www.winzip.com/downprob.htm for hints on resolving download problems.

If you did not download this file, and it is not part of a backup set, it is either not a valid Zip file or it is
corrupt, perhaps because of a bad diskette.




Message WZ44

An invalid CheckOut folder was specified. You cannot specify a root folder (e.g. C:\), and you must
specify a drive letter (e.g. C\CHECKOUT, not just CHECKOUT). The CheckOut folder cannot be the
folder containing the open archive, since all files in the CheckOut folder are deleted at the beginning of

the CheckOut operation.



Message WZ47

WinZip could not create the specified folder. Possible causes are:
¢ Afile exists with the same name as the folder
e Disk is read-only

e Folders preceding the final folder do not exist. For example, to create the folder “C:\UTILITY\
FILES” the folder “C:\UTILITY” must exist.

Solution: specify a different folder name.



Message WZ48

Due to a limitation in Windows, it is impossible to remove a Program Group while closing Windows.
Thus, if you want to remove Program Groups created by WinZip, you need to close WinZip before

shutting down Windows.



Message WZ50

An error occurred opening, writing to, closing, or deleting the specified file. Possible causes include a
misspelled filename, a full disk, a read-only or locked disk, or a read-only or locked file. The operation in
progress will be aborted. Another dialog box with more specific information may be displayed.

This message may also be displayed because of an invalid archive. For example, if an archive is
damaged (possibly due to line noise while downloading from an online service) it may contain invalid

data.



Message WZ51

The open archive no longer exists on disk. It was probably deleted by another task.



Message WZ52

Nothing To Do: no files were found for the specified action. Examples of when this message is issued
include attempts to add a non-existent folder to an archive and attempts to freshen an archive that is
already up to date.



Message WZ53

An invalid archive operation was initiated. For example, an attempt to add the same file from two
different folders can cause this error. Check the warning messages for additional details about the

problem.



Message WZ54

This error occurred during internal Zip processing. Correct the error and retry the operation.



Message WZ55

WinZip could not access the correct version of the specified DLL. It is possible that the DLL from a
previous version of WinZip is still loaded, or that the wrong version of the DLL is in the WinZip folder. To
solve this problem follow both of these steps:

1. Verify that the DLL in your WinZip folder has the same date as WINZIP.EXE or WINZIP32.EXE.
If not, reload all WinZip related files from the distribution disk. DO NOT use WinZip to extract
files from the online distribution version of WinZip to the folder from which you are running
WinZip, since that can cause unpredictable results.

2. Exit Windows and then run WinZip again. Closing Windows ensures that old versions of the DLL
are not loaded.



Message WZ57

There is insufficient free memory (RAM) on your system. Close one or more other applications and retry
the operation.



Warning WZ58

One or more warning messages were issued. Press the Yes button to view all messages issued while
processing the last action, including informational and warning messages.



Virus Scan Complete.

This message is issued when a Windows-based virus scanning operation completes. If no error or
warning dialog boxes were displayed by the virus scanner, then this dialog box indicates that no viruses
were found. The Norton Anti-Virus scanner, the Central Point Anti Virus program, and any other properly
configured virus scanner will display error or warning dialog boxes if a virus is found.



Message WZ62

WinZip could not copy, delete, rename, or move the file. Possible causes include: the file is read-only,
the file is open by another process, or the file has already been deleted by another process.



Message WZ64

WinZip uses the standard Windows “Common Dialog Boxes” as a basis for the Add dialog box. Due to a
limit in the Common Dialog Boxes the total length of all selected files cannot exceed 2000 characters.
You have exceeded or may exceed this limit. You can circumvent this limit by using the Drag and Drop

interface to add files instead of the Add dialog box, or by specifying wildcards in the Add Files field in the
Add dialog box (for example, *.c).



Message WZ65

WinZip could not make the specified folder the current folder. Probable cause: invalid or non-existing
folder name.



Message WZ66

The temporary folder must be a fully qualified path. You must specify both the drive and folder, for
example, C:\\TEMP or C:\WINDOWS\TEMP. |If you don't know the location of your temporary folder, click

Cancel.



Operation Interrupted

The archive operation was interrupted because you pressed a key or clicked on the WinZip window
during the archive operation. Press the Continue button to continue the operation or the Stop button to
terminate the operation.

This message will be displayed if you try to minimize WinZip during an archive operation. To switch to
other tasks you can click on another window or use the task list (press Ctrl+Esc).



File Is In Use

Afile can be “in use” for one of two reasons:

e The file is open by another process. For example, a document might be open by a word
processing application.

e The file is “in use” by Windows. Files that are “in use” are typically programs (.EXE files) or
dynamic link libraries (.DLL files) being run by the system. For example, you will get this
message if you attempt to overwrite C:\WINZIP\WINZIP.EXE while running C:\WINZIP\
WINZIP.EXE. The solution is to extract to a different folder, for example, C:\WINZIP5 instead of
C:AWINZIP.

WinZip will not let you overwrite or delete a file that is “in use” by the system because this operation could
cause unpredictable results, including system crashes. Windows may read from files that are “in use” at
any time, and does not expect these files to change. If the file has been overwritten Windows will not
know the data has changed and can become confused.

If this message is issued during an Extract operation you can either extract the file to a different folder, or
retry the operation after closing the program that is using the file.

If this message is issued while WinZip is trying to delete a folder or file you can either continue without
deleting the folder or file (and delete it manually later on) or close the file in question and re-try the
operation.



Message WZ67

Cannot create filename. File already exists. Open existing file?

This message is issued when you press the New button on the toolbar or select New from the File menu
to create an archive but the specified archive already exists. Since the file already exists it cannot be
created. Press the Yes button to open the existing file or the No button to cancel the operation.

Normally you should press the Open button to open an existing archive.



Message WZ68

Cannot open filename. File does not exist. Create new file?
This message is issued in one of two situations:

e You pressed the Open button on the toolbar or selected Open from the File menu and specified
the name of a file that does not exist.

¢ You selected a filename from the File menu history list, but that file no longer exists.

Since the file does not exist it cannot be opened. Press the Yes button to create a file with the specified
name or the No button to cancel the operation.

Normally you should press the New button to create an archive.



Message WZ69

Due to Windows limitations it is not possible to run two different versions of the same program with the
same name at the same time. As a result, you cannot use WinZip's Install/Try/Uninstall feature to install

WinZip.



Message WZ70

This dialog box is displayed when Windows returns a “File Not Found” error when WinZip tries to run
another program. Possible causes include:

e A program specified as a Windows association was deleted from your system or was moved to a
different drive or folder.

e Arequired DLL or other component is not installed (e.g. VBRUN300.DLL).



Message WZ71

WinZip could not create a folder because a file (not another folder) with the same name exists. For
example, if a file named “foo” exists you cannot create a folder called “foo” in the same folder. Choose
a different name for the folder you are trying to create, or delete the file with the conflicting name.



Message WZ72

For seamless integration with WinZip your virus scanner must support automatic scanning. At the time
this version of WinZip was released MWAYV did not to support automatic scanning.  Click Yes to continue
if you are sure your version of MWAV supports automatic scanning, otherwise press No and select a

different scanner.



Message WZ73

WinZip was unable to make the folder displayed in the Add dialog box the current folder. In some
operating environments this can be caused by using UNC names. Another possible cause for this
problem is a conflict with a “common dialog box” enhancement utility.



Caution

The Caution dialog box lists items that cannot safely be uninstalled but were changed during the install
process. These items are unlikely to interfere with a successful uninstall. For example, a setup
program might replace your existing copy of a common dynamic link library like CTL3D.DLL with the
latest version of the same library. In normal situations your existing applications should work with the
latest version of the library, so leaving this new version installed will not cause problems.



WZ74

This archive contains files with long filenames or blanks. However, you are using an external archive
utility (e.g. LHA or ARJ 2.50) that doesn't support long filenames. Thus some (or all) operations involving
this archive will fail. For example, if the archive contains the file “A LONG NAME” and you try to extract
it using LHA, the file will be called “ALONG N”.



WZ75

The archive does not contain complete filename information, so WinZip cannot determine the full filename

of the compressed file. Replace all or some of the suggested filename with the corrected name and
press OK.



WZ76

This compressed file contains an archive. Normally you will want to have WinZip automatically
decompress and open the archive. If you choose Yes WinZip will

1. Decompress the archive into your temporary folder (as specified in the Options/Folders dialog
box).

2. Open the archive in the temporary folder.
3. Later, when you close the archive in the temporary folder, WinZip will automatically delete it.
Note that the original compressed file is not changed by this operation.



WZ77

This compressed file is stored in the “KWAJ” format introduced after Windows 3.1.  Your copy of the
LZEXPAND.DLL or LZ32.DLL cannot handle this compressed file. The version of LZEXPAND.DLL
distributed with Windows for Workgroups 3.11 works fine, while the old one distributed with Windows 3.1
will not work. Unfortunately, the LZ32.DLL distributed with initial release of Windows NT 3.5 will not
handle these files, and Microsoft has not released documentation on this file format. You can usually
decompress these files with the EXPAND command (from the DOS command prompt enter “expand /?”
for instructions).



WZ78

The file you tried to open does not appear to be in the Microsoft Compress (LZEXPAND) format. Note
that not all files ending with an underscore are in the Microsoft Compress format.



WZ79

WinZip could not create or replace the specified Zip file. WinZip created or updated the Zip file in the
temporary working folder, but was unable to copy the result to the destination disk. The most likely
cause for this error is a full or write-protected disk. The updated file is left on your hard disk with the
specified filename. After correcting the problem (e.g. freeing up some disk space or removing the write-
protect tab from the disk), you can copy the specified filename to the destination disk manually.



WZ83

The SETUP or INSTALL program in this archive contains folder information, for example, win32\setup.exe
and/or win16\setup.exe. Use Actions/CheckOut instead of Actions/Install for this archive.



WZ84

WinZip encountered a problem processing a UUencoded, XXencoded, MIME, or BinHex file. Details on
the problem are in the message text. Possible causes for this message include:

e The file is corrupt. In this case, you will need to obtain another copy of the file.

e The file contains incomplete header information. Be sure not to remove any header information,
including subject fields, and MIME headers. For example, never delete anything that looks remotely
like this

Content-Type: multipart/mixed; boundary="----
= NextPart 000 01BB5CFA.BB6BBCSO"

Content-Transfer-Encoding: 7bit

—————— = NextPart 000 01BBSCFA.BB6BBC80--

Hint for Microsoft Mail (MS-Mail) users: if you receive an encoded file by e-mail, save it to disk before
opening the message. Just select the message while it is in the inbox, then choose “File/Save As” and
select a filename such as “message.uue”. If instead you double click on the message, it may be
truncated, because MS-Mail limits message text to about 16kb.



WZ85

The Favorite Zip Folders dialog box current shows the results of searching one or more disks. You have
changed the search criteria (for example, from searching for all Zip files to all encoded files), so WinZip
needs to re-scan the disk(s) for files matching the new search criteria. This could take a few moments.
Click Yes to start the search now.



WZ386

The PRE-RELEASE BETA TEST version of WinZip you are using should be replaced with the current
version of WinZip. You can always download the current version from WinZip web site:

http://www.winzip.com



WZ388

Windows is not configured to recognize this type of file, so WinZip does not know which program to open
for you to view it properly. For more information on associations and how to instruct Windows to know
which program is required for this file type, see the section titled Windows Associations.



WZ389

The version of the Windows Common Control Library (comctl32.dll) installed on your system may not be
able to properly display flat toolbars. At the time of this writing, the version of the Common Control
Library you have installed was distributed only with Microsoft’s Active Access Pack, and the latest version
of the common control library available from the Microsoft web site did not support all the Active Access
Pack features.

We expect Microsoft will update the Active Access Pack and/or the Common Control library in the not too
distant future. See the section titled Windows Common Control Library for a pointer to up-to-date
information.




WZ90

Opening this .REG file will cause new data to be merged into your system registry. Improper merges
may cause damage to your registry, lost associations, etc. Press OK to continue or Cancel if you are not
sure you want to merge this .REG file into your registry.



WZ91 - CRC Error

About CRC Errors

A CRC error indicates that some data in your Zip file is damaged. CRC stands for “cyclic redundancy
check”. It is a calculation made from all the data in a file to insure accuracy in transmission. When you
add a file to a Zip file, WinZip calculates a CRC value for the file and saves the value in the Zip file.
When you later extract the file from the Zip file, WinZip calculates the CRC of the extracted file and
compares it to the value stored when the file was zipped. If these two CRC values do not match, the file
that was extracted does not match the original file, and WinZip will display a “CRC Error” message.

When the data in a Zip file is damaged, it may not be possible to extract all of the files from the Zip file
correctly. Damaged data can affect the entire Zip file, multiple files, or just one file.

Why CRC Errors Occur

There are many possible causes for data damage. Among the most common is telephone line noise or
some other transfer error when downloading a Zip file from an online source such as the Internet,
CompuServe, or AOL. Such an error can introduce invalid data into a Zip file. Some other possible
causes include exposure of disks to excessive temperatures or magnetic fields, cross-linked disk sectors,
and mechanical problems with disk drives.

What to do if a CRC Error Occurs

The best solution to the problem of a damaged Zip file is to try to obtain another copy of the file. For
example, use your backup copy of the file or get a new copy from the original source. If you obtained the
Zip file by downloading it, then downloading it again will almost always solve the problem.

CRC Errors on Removable disks

If the damaged Zip file is on a removable disk, the removable disk may be physically damaged, or the
data on it may have been corrupted. In these cases, the only completely reliable solution is to use
another copy of the disk or Zip file that is undamaged. There are, however, two other situations in which
it may be possible to recover some files from a removable disk.

e The removable disk drive that you are using to unzip the Zip file may be malfunctioning. Try using a
different disk drive, if possible.

e [f the removable disk drive you are using to unzip the Zip file is not the same drive that was used to
store the Zip file on the removable disk, and you have access to the original drive, try using this drive
to unzip. Itis possible that the original drive may be able to read the disk; if so, you can extract your
files using this disk drive (and have your removable disk drives checked out — at least one of them
may be out of alignment). Otherwise, the removable disk itself or the data on it is probably damaged.

A “Last Resort” for CRC Errors

If you cannot download a new copy of the Zip file, obtain a replacement disk, or use a backup copy, you
may still be able to recover some of your files, and even save portions of the files that are damaged in the
Zip file. Here is the recommended procedure.

1. Start WinZip, switch to the Classic interface, and open the damaged Zip file.
2. Select Extract from WinZip’s Actions menu, or click the Extract button on the WinZip toolbar.

3. In the Extract dialog, check the All Files option button and select the folder into which you want to
extract files. Then click OK.

4. WinZip will extract any undamaged files to the selected folder; for any damaged files, WinZip will
display a CRC Error message. For each such file, before clicking OK in the error message window,
use Windows Explorer to open the extract folder and look for the file; some portion of it will probably
already have been extracted. Copy the partial file to another folder and then click OK in the WinZip
error message window. This will erase the partially extracted file from the extract folder, leaving
intact the copy of the file you made in the other folder.

Whether or not a damaged file partially recovered using this procedure will be useful depends on the



nature of the file, what kind of damage there is, how much of the file was recovered successfully, and
what kind of program(s) use the file. In some cases, a partial file is of no use at all; in some cases,
loading a partial file into your application program and re-saving it will completely restore the data. In
other (perhaps most) cases, the result will lie somewhere between these two extremes--some of the data
will be recovered, and some will be lost.



Association Problem

Some of WinZip's most useful features require that WinZip is associated with Zip files and other archives.
For more information on associations see the section titled Windows Associations.

It is strongly recommended that you answer Yes to this prompt.
Press the Info button for diagnostic information.



Association Problem Details

This dialog box lists the following information:
Full filename of current WinZip: note the exact drive and folder information.

Current Zip association: this field should include the EXACT name of the “current WinZip” shown
above. If this filename is different it is possible that you have two copies of WinZip installed in different
folders. In this case you will probably want to remove the older copy.

Current registry value of the Zip key: this value should be “WinZip”.



Association Information

If the Associate WinZip with archives option is unchecked you will not be able to double click on Zip
files and other archives to open them. Other features, including Explorer shell extensions, rely on having
WinZip associated with archives. For more information on associations see the section titled Windows
Associations.



Windows Common Control Library

Some toolbar configuration options require version 4.71 or later of the Windows Common Control library.
This library is part of Windows 98, Microsoft Internet Explorer 4.0, and is available as a separate
download from Microsoft. For more information, see the web page
http://www.winzip.com/common_control library.cgi.




Installing QuickView

Use Quick View, the optional Windows 95/98/NT file viewing utility, to view files without associations. If
Quick View is not installed on your system, you can install it as follows: open the Windows 95/98/NT CD-
ROM, click Add/Remove Programs, double click Accessories, check the “Quick View” box, then click OK.
To use Quick View with WinZip, select Configuration from WinZip's Options menu, click the Program
Locations tab, type “quikview” in the Default association field (don't type the quotes), then click OK.



Search for Favorite Zip Folders

Click Search entire hard drive to search all hard drives on your computer for folders containing .ZIP files
and folders name “download” or “dnload”. Click Quick Search to search only for a few folders likely to
contain Zip files (e.g. cserve\download and aol\download).

Floppy drives, network drives, and CD-ROMs are not searched. To search for files on these devices,
click the Search button in the Select Zip File panel (in the WinZip Wizard) or the Favorite Zip Folders
dialog box (in WinZip Classic), then click | know where it is.

Details on the File Type filters in the Search for files of type combo box are documented in the section
File Type Filters.



How do | compress a folder and later restore it?

Note: there are easier ways to do this, but this is the easiest to explain. In particular, using the drag and
drop interface or the WinZip menu entry in the File Manager can save you most of these steps.

How to compress a folder and its subfolders:

1.
2.
3.

Start WinZip
Select New Archive from the File menu

Type the name of the archive, for example:
C:\MYDIR.ZIP
and press the Enter key

Select Add from the Actions menu

Type the full filespec of the files you want to add, for example:
C:\MYDIR\*.*

Be sure the Include subfolders box is checked and the Save extra folders info box is not
checked

Press the Add with wildcards button. (In Windows “wildcards” are the asterisk and question
mark characters. These let you specify multiple files at once, for example, “*.Txt” refers to all
files with a file type of “Txt.)

How to restore a folder and its subfolders:

N~

Start WinZip and open the Zip created in step 1 above
Select Extract from the Actions menu
Be sure the Use folder names checkbox is checked

Type the destination folder, for example
C:\MYDIR

Press the Extract button



How do | view graphic/spreadsheet/word processing files in
an archive?

Quick View, the optional Windows 95/98/NT file viewing utility, makes it easy to view many popular
graphics, spreadsheet, and word processing files. By default, if Quick View is installed on your system,
WinZip will use it to view files that are not associated with another application. If Quick View is not
installed on your system, you can install it by reviewing the Installing QuickView topic. To use Quick
View with WinZip, select Configuration from WinZip's Options menu, click the Program Locations tab,
type “quikview” in the Default association field (don't type the quotes), then click OK.



Do you keep track of address changes?

We track address changes, so we can send you upgrade notifications. If you purchased a copy of
WinZip and have moved, please send us the following information:

1.

o g kW

Your name (If you are not sure how you spelled your name when you registered, please include
common alternate spellings, e.g. “J. E. Smith", “Jim Smith", etc).

Your e-mail address, if any (please double check it! almost 10% of the people that sign up for
our mailing list type an invalid address; e-mail addresses are notoriously difficult to spell
correctly).

Your new postal mailing address.

Your old postal mailing address.

Approximate purchase date.

Important: please indicate how you purchased WinZip:
By check

Via PsL (Credit Card order via Public Software Library)
CompuServe's SWREG service

Reseller (please include reseller name)

Thank you!



WinZip Internet Browser Support Add-On

The free WinZip Internet Browser Support Add-On will automate much of the work normally associated
with downloading compressed files from the Internet. When you click on a Zip file using Netscape
Navigator/Communicator or Microsoft Internet Explorer, WinZip will take over when the download is
completed. WinZip automatically moves the downloaded file to your download folder (initially set to c:\
download) and then, optionally opens the file.

Notes:

WinZip's Internet Browser Support Add-On is not part of the WinZip distribution package; it is available as
a free download from the web page http://www.winzip.com/ibrowser.cgi.

WinZip's Internet Browser feature supports Microsoft Internet Explorer and Netscape
Navigator/Communicator, and depends on the implementation these browsers use for “helper”
applications. WinZip 7.0 has been tested with the latest release and the latest publicly available beta
versions of Microsoft Internet Explorer, Netscape Navigator, Windows 95/98/NT, as of July 1998. ltis
possible that at some point in the future the browser vendors will release new versions of their browsers
with different interfaces and conventions that are incompatible with WinZip 7.0's Internet Browser
integration. If this happens, we plan to adjust WinZip to make it compatible. We cannot guarantee that
this will be practical, however, and it is possible that WinZip's Browser Integration will not be available for
future versions of these browsers.



Command Line Support Add-On

Note: at the time of this writing, the command line support add-on has still not been officially
released, but a pre-release beta test version is available as a free download from the web page
http://www.winzip.com/wzcline.cqi.

The WinZip Command Line Support Add-On lets you use WinZip’s power within batch files, macros, and
other situations where you have a specific task and would prefer to accomplish it quickly or automatically,
without using the usual WinZip graphical user interface.



Install/Try/Uninstall Feature

Beta Feature Only A pre-release Windows 95/98/NT version of this feature is available
from the WinZip web site at http://www.winzip.com.

WinZip's unique Install/Try/Uninstall feature makes it easy to install and uninstall software distributed in
archives. This feature can save megabytes of disk space by tracking and removing all traces of an
application. WinZip will run the installation program in an archive, give you a chance to try the program,
and optionally offer to restore your system to its original state. The uninstall step can selectively remove
files, icons, or program groups created by an install program, and can restore any altered INI files. You
have complete control over the uninstall process, and no changes are made without approval.

Note: the Install feature is only available if an archive contains an “install” or “setup” program. If the
Install button is not displayed, use the CheckOut Feature to try the software in the archive.

To use the Install/Try/Uninstall feature

1. Press the Install toolbar button or select Install from the Actions menu to extract all files to a
temporary folder and run the install program.

2. Try the program that was installed.
3. Decide whether to leave the program installed or to uninstall.
If you choose to uninstall WinZip will display the Uninstall dialog box which will let you select whether to
e Delete any Groups and Icons created by the installation process.
e Delete any Folders or files created by the installation process.

¢ Restore your autoexec.bat, config.sys, reg.dat, or ini files if they were changed by the installation
process.

Restrictions:

¢ All configuration changes made between an install and uninstall are considered to have been
made by the install process. For example, if you switch to your word processor and save a
document during the installation process, the document is considered to have been created as
part of the install process. If you subsequently uninstall, WinZip will list the document you
created in the Uninstall dialog box along with files created during the install procedure.
Therefore it is strongly suggested that you do not run any programs other than those related to
the program you are installing until you have decided whether to uninstall.

e The uninstall procedure does not let you restore files that are changed or deleted unless they are
one of the special files that are backed up during initialization: autoexec.bat, config.sys, reg.dat,
and the .ini files in your Windows folder.

Notes:

The uninstall feature does not notice files or folders created from DOS boxes (after all, this is a Windows
program!).

The uninstall feature does not attempt to save information across sessions.

The Install operation requires that the entire product being installed is distributed in one archive.

WinZip determines whether an archive contains an install or setup program by checking for a file that 1) is
executable, 2) has “install” or “setup” in the filename, and 3) does not contain folder information. If no
file matches these criteria the Install operation is disabled.

Related Topics:

uestions and Answers About Install/Try/Uninstall
Install Dialog Box
Uninstall Dialog Box






Questions and Answers About Install/Try/Uninstall

Beta Feature Only A pre-release Windows 95/98/NT version of this feature is available
from the WinZip web site at http://www.winzip.com.

Here are answers to the three most frequently asked technical questions about WinZip's
Install/Try/Uninstall feature:

Question: Why shouldn't | run unrelated programs during an install?

Answer: All configuration changes made between an install and uninstall are considered to have been
made by the install process. For example, if you switch to your word processor and save a document
during the installation process, the document is considered to have been created as part of the install
process. If you subsequently uninstall, WinZip lists the document you created in the Uninstall dialog box
along with files created during the install procedure. Therefore it is strongly suggested that you do not
run any programs other than those related to the program you are installing until you have decided
whether to uninstall.

Question: What does WinZip do if a SETUP program replaces an existing DLL or VBX file?

Answer: WinZip's uninstall feature will never suggest you delete files that are used by other programs.
WinZip “watches” the setup process, and notices whether any existing files were replaced. If you later
choose to uninstall a program WinZip will list changes to pre-existing files in the Cautions dialog box, and
will not list them in the Uninstall dialog box, so these files cannot be accidentally deleted. Since no well-
behaved SETUP or INSTALL program will replace existing files with older versions of the same file, and
since all well-behaved DLLs and VBXs are designed so that new versions don't break programs relying
on old versions, there should be no negative effects on your system.

Note that WinZip does not backup all files on your system before running an install, so it is possible for an
ill-behaved SETUP or INSTALL program to “break” other applications. However, in no case will you be
worse off running WinZip with the Install/Try/Uninstall feature than if you run the SETUP or INSTALL
program without WinZip.

Question: Can | use WinZip to install a program, try the program for a week, and later use WinZip to
uninstall it?

Answer: No. WinZip's Install/Try/Uninstall feature was designed for the highest possible reliability. You
must decide whether to uninstall in the same session that you install. The advantage to this approach is
that WinZip has a very high uninstall success rate with a very easy to use interface. It is almost
impossible to guarantee a safe uninstall if you've had a chance to install other programs, make arbitrary
changes to your system configuration, etc. However, you can use the Report button in the WinZip
Uninstall dialog box to generate a disk file listing files that were changed, and use this file to manually
uninstall the program. In this case it is up to you to determine whether any programs you've since
installed depend on files that are part of the original install.



Uninstall Dialog Box

Beta Feature Only A pre-release Windows 95/98/NT version of this feature is available
from the WinZip web site at http://www.winzip.com.

The Uninstall dialog box displays a list box containing one entry for each item that can be uninstalled.
Entries are created for

e Groups and icons created by the installation process.
e Folders or files created by the installation process.
e Configuration files (e.g. win.ini) changed by the installation process.

Each entry contains a check box and a description of the action. Select or deselect the check boxes
depending on whether you want to uninstall the configuration change. Usually it is best to remove all
entries, however, this dialog box gives you a chance to avoid removing any files or icons you want to
keep.

e The Select all button selects all check boxes.

e [f a Cautions... button is displayed in the Uninstall dialog box press it for information about
system configuration changes that the uninstall procedure cannot restore, for example, dynamic
link libraries in your Windows that have been replaced.

e Press the Report... button to save a list of the suggested actions to a disk file.

¢ Press the Uninstall button to begin the uninstall, or Cancel to terminate the operation.
Additional confirmation dialog boxes may be displayed depending on the specifics of the program
being uninstalled.

Notes:

All actions in the Uninstall dialog box are automatically checked except file deletions. Individual files are
not selected for deletion in case you created files using some other application during the install process;
however, you can use the Select all button to quickly select all checkboxes in the list box.

If you decide to cancel the uninstall operation you may wish to create a report using the Report... button
to assist a manual uninstall.

Install Dialog Box Beta Only Addendum

The Install dialog box gives you an additional option in the beta version:

e The Save configuration information for possible uninstall check box determines whether
WinZip will save information about your program groups, icons, and ini files. This information is
required for an uninstall operation, so if this checkbox is not selected you will not be able to use
WinZip to uninstall.






